DiskBase 5 for Windows - Disk Cataloging Program
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About DiskBase

DiskBase is a disk cataloging program, i.e. it is able to read all the file and folder names from a disk and save it to its database. Then you can display the disk contents in a natural way and search in it - without necessity to have the disk present in the computer.

This ability can be widely used namely with replaceable disk media, like floppy disks, CD-ROM, CD-R, ZIP, JAZ, optical disks, Bernoulli disks and any other disk media that behave as a standard disk in Windows. But not only that. DiskBase can also be used with fixed or network drives, as it is described later in this chapter.

Storing just names of files and folders into the database might not be enough for searching. But DiskBase is also able to extract the names of files and folders from archives created by common compressing programs, like ZIP, RAR, ARJ, LHA and other (including self-extracting archives). Moreover, DiskBase is also able to store a description for each file or folder; you can do that either manually or let DiskBase to do it automatically by scanning the content of the file. With these features DiskBase is a powerful tool for keeping your disk archive clearly arranged.

Unlike most other disk cataloging programs that show disk contents as one long flat list of files, DiskBase offers the user interface similar to interface of common file managers - with a tree and a list of files in current folder displayed. If you are comfortable with file managers like Norton Commander or Windows Explorer, you will find DiskBase easy to use.

There is also no need to install any database engine in order to run the program. DiskBase (in its 32-bit version) supports long file names, used in Windows 95/98 and Windows NT.

DiskBase 5 is distributed as shareware. The author of the program is Zdenek Martinek.

For What is DiskBase Useful?

Let us give you a few examples for an illustration of DiskBase usage:

1. You are looking for a file with a (bit un)certain name, like "ACMELOGO.BMP" in a big heap of disks. Moreover, the file is probably hidden in some archive like ZIP or ARJ. You can spend dozens of minutes, even hours to find it. DiskBase, however, can do the search in seconds. Even if you do not have the disks scanned in a database, it is often faster to scan them first and then let DiskBase make the search, than to look for the file on disks manually using Windows Explorer or some other file manager.

2. One of the common backup strategies is to make a cyclic backup, i.e., you do not backup on one media (floppy disk, for example), but iterate through multiple media (10 for example) with the rule that the new backup is placed on the disk with the oldest backup. But how can you find, on which disk is the oldest backup? With DiskBase easily: it can sort a list of found files according to their date.

3. The short 8.3 file names from DOS are history now - but still too young history. Many files still have short, hardly understandable names. You are searching for some file, but cannot remember what name you gave it - was it CURVIATE.DOC or CV.DOC or CURRIC.DOC or anything completely else? If you are using descriptions in DiskBase, you can search for "Curriculum Vitae" and you will find it. Or you can remember approximate date when you last modified the file and it may also be enough for finding it. These features of DiskBase are useful not only for replaceable media, but also for fixed disks.

4. As a LAN Administrator you want to save information about the current state of network volumes. No problem with DiskBase. Also repeated searching on network volumes can be much faster using DiskBase (and a local database) than direct search on the volumes.

5. You are creating a CD-ROM with thousands of files. To give a fast orientation on the slow CD-ROM to the users, you can add unregistered version of DiskBase with the read-only database of the CD-ROM contents to the CD-ROM (such usage of DiskBase is free of charge - see the Trial Use License). 

And so on...

How to Make the Database Up-to-date?

Well, this is the only thing, that requires a bit effort from you: you should run DiskBase disk scanning process each time you changed something on the disk and are going to remove it from the drive. Unfortunately this cannot be automated: there is no way, how the program on a PC can recognize that you are going to eject a disk. 

However, scanning a disk by DiskBase is really a simple task. As it is explained in the Command line mode chapter, you can even create a icons for running DiskBase with various parameters that cause DiskBase to run, scan a disk and terminate automatically. DiskBase also has smart time-saving features; for example if you a have a slow floppy disk full of archives, only contents of modified archives is read when the disk is already in the database.

See also:
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Program Installation and Uninstallation

You probably already have DiskBase installed when you are reading this help text. If it is so, just skip the next two paragraphs.

The program is distributed in two files: SETUP32.EXE and DSKBAS32.DAT. The SETUP32.EXE program unpacks the contents of the DSKBAS32.DAT file into a specified folder and creates items in the Startup menu. Then it is not needed anymore.

Uninstallation

The Uninstall program removes all unmodified files belonging to DiskBase from your computer and cleans the appropriate items in the system Registry. The Uninstall program is available in the Start -> Programs -> DiskBase menu and in the Start -> Settings -> Control Panels ->Add or Remove Programs. 



Program Installation and Uninstallation

16-bit and 32-bit Version of the Program

DiskBase 5 exists in 2 versions: 

--	16-bit, to be used in Windows 3.1x

--	32-bit, to be used in  Windows 95/98 and Windows NT4; 

The 16-bit version can be run also in Windows 95 and NT, but not vice versa: The 32-bit version will not function in Windows 3.1x even if they are extended by Win32s. But there is no reason to do that: the license for DiskBase is valid for both versions and both versions use the same database structure, so you can easily switch from 16-bit to 32-bit version if you upgrade from Windows 3.1x to Windows 95,98 or NT4.

Differences Between Versions

Till version 5.10 there were only two significant differences between the 16-bit and 32-bit versions: The 32-bit version is able to work with long file and folder names (used in Windows 9x and NT) and is able to set volume labels on disks.

The 16-bit version development was stopped by version 5.11. Now the new features are added to the 32-bit version only. See What is new in this version for more information about the new features.



Quick, Step by Step Introduction to the Program

This chapter will show you the elementary program functions in several simple steps..

Step 1: Creation of a New Database

Run DiskBase. In the menu "File" select "New database...". Then, in the standard file dialog box select a folder for storing the database, type in the name (without extension: QDR extension will be added automatically). After confirmation of file dialog box a database window appears. The database is now opened.

Step 2: Scanning a Disk

In the "Edit" menu select "Scan disk...". A dialog box for disk selection appears. Select the disk you want to scan. DiskBase will then ask for the name, under which the disk contents should be stored to the database. As default name the volume label of the disk is offered. Then DiskBase scans the disk and stores it to the database. The time needed for that depends on the number of files, folders and archives on the disk and on the disk speed.

After scanning is completed the disk is displayed in the database window. By repeating this step you can scan as many disks as you need to the database.

Step 3: Options for Display

The window with database is split into three panels: Left one with names of disks, middle one with the tree of folders of the current disk and the right one with a list of folders and files in the current folder. You can use the <Tab> key to switch between the panels. In the "Settings" menu (beginning from the "File names only" command) the commands that change the display options can be found. Try it. 

Step 4: Searching in the Database

Select "Find files..." command in the "Search" menu. Enter the name of the file you want to find in the dialog box. If you want to find more files, you can write more names separated by spaces. You can also use a wildcard convention, like *.txt to find all files with the ".txt" extension, for example. When you confirm the dialog box, a sequential search is started. After the search is finished, a new window with found items is displayed. When you double-click on some item, you are switched to the window with database and the corresponding disk, folder and file are displayed.

You can switch between the two windows using the "Window" menu or by pressing buttons on the toolbar (will be explained in detail in the MDI interface of the program chapter).

When you have the database window displayed, try also the "List of free space" command in the "Search" menu.

Step 5: Editing Descriptions

Switch to the window with database and click on some file name in the right panel. Then, in the "Edit" menu select the "Description" command. A window with the description editor is displayed. You can enter any text there. Try it and then close the edit window. In this way you created a description for a file. With the same procedure you can edit already existing description. If you set the detailed display for the right panel, you can see parts of descriptions in the rightmost column.

Now try to create a few descriptions and then repeat the Step 4 (searching) again, but in this case enter in the search dialog box some words which you used in the descriptions. You will see that DiskBase fill find the files, descriptions of which contain these words.

Step 6: Automated Description Creation

DiskBase is able to create descriptions automatically by scanning the contents of a file. The simplest case are the pure text files, which usually have the ".txt" extension; extracting a description for such files means just copying a part of the file to the description. 

Maybe you noticed, that by the files with .txt, .doc, .htm, .rtf and .mp3 extensions a description is already present - as a default setting, DiskBase sets rules for creating descriptions by these files automatically when a new database is created. You can modify the rules by yourself: in the "Settings" menu select the "Database settings..." command. In the dialog box select the "Descriptions" card. You will find detailed information about it in the Descriptions chapter.

You should prefer this automated creation instead of manual editing the descriptions wherever you can.

Step 7: Print

In the "File" menu select one of the printing commands, for example the "Print -> Print tree..." command. Print the tree by using standard Windows steps. 

And What Else?

The above stated steps showed the features of the program very briefly. In the next chapters you will find detailed description of the program functionality. The whole text of this document is not too long and we recommend you to read it all - you will find a lot of information how to use this program effectively.



Detailed Program Description

In the next text we will use this convention for a menu-based command: "Menu -> Submenu (-> Card)". For example: "Settings -> Program settings... -> Font" means to select the "Program settings..." item in the "Settings" menu and in the displayed dialog box to select the "Font" card.



MDI Interface of the Program

As a lot of other programs, DiskBase uses MDI (Multiple Document Interface), which means that inside the main program window multiple child windows can be displayed. In DiskBase the windows are of three types.

--	window with database, 

--	window with found files, 

--	window with the list of free space.

If you close the window with database, automatically all the windows, that belong to this database are closed.

The MDI interface is universal, but not very practical. Although you can have dozens of child windows displayed, still even a large screen is usually too small to have more than two or three windows displayed. 

So the default setting of DiskBase is to have child windows maximized, i.e. one window uses all the area and other windows cannot be seen (note that when you maximize one child window in MDI, all child windows are maximized - it is a Windows feature). Most users prefer this setting. To switch between windows you can use the "Window" menu or keyboard shortcuts <Ctrl-Tab> and <Ctrl-Shift-Tab>.

You can open as many databases as you want; but in real life you will work mostly with one database only. In the Program settings chapter you will find, how to set the name of the database that is to be opened automatically at program startup.

In real life you also probably prefer not to have the number of windows increased after each search. That is why the default setting of DiskBase is to reuse the existing window, so only one window is used for displaying the search results belonging to one database; each new search overwrites the previous one in the same window. You can disable reusing windows in the Program settings.



Menu, Toolbar with Buttons

The main program window has common controls: menu, floating menu, hot keys and toolbars. 

Some commands in the menu might be disabled in case the corresponding function does not make sense in the current program status. For example, when there is no window with found items available, the command "With found items" in the "Window" menu is disabled. Similarly, a lot of commands are disabled when the window with the database is not at the top (scanning a disk is disabled in such case, for example).

There is also a floating menu available when you click with right mouse button over a window. This menu lists commands related to the place over which you clicked (i.e. window or panel).

Note that the often used commands have their hot keys; for example you can edit a description simply by pressing <F2> or <Ctrl-Enter>, without necessity to go to the menu. These hot keys are listed on the right side of the menu commands and we will no more mention them in the following text because you will easily find the usage of them after some time of working with the program using the menu. 

The third alternative way how to execute some command is to press a button on the toolbar. These buttons correspond to commands in the menu and you will find a description of each button when you place a mouse cursor over the button for a while (without pressing it).



Creation of Database

You can create a new database by the "File -> New database..." command. The whole database is stored in a single file. The default file extension for it is the ".QDR" extension (comes from the DiskBase original name - QuickDir). If you specify just the name, without an extension, this default extension is added automatically.

A new database does not have zero length, although it is empty - the empty database takes about 64 kB of space, because it already contains a header and an index table. With each change then the size of the database grows. For example, when you scan a disk to the database, the old disk of the same name in the database is not overwritten, but just marked as deleted (so it can be undeleted if needed), and the new one is stored physically at the end of the database, increasing the size of the database. DiskBase reuses parts of old records, so if you rescan a disk, which is already in the database, the database might grow substantially less than when scanning a new disk.

This increasing of the database size is not visible in the program; visually the newly scanned disk replaces the old one, the edited description replaces the old one and so on. So it is important to remember this fact and not to forget to make a Compressing the database from time to time. The compression copies the content of the database into the new one, skipping all the deleted items in the database.

The database is not intended for multi-user access; it can be opened by one program at a time only. It must be placed in the folder that is accessible for reading and writing, otherwise all edit functions become disabled.



Scanning a Disk

When scanning a disk, always the names of folders and files are scanned and, according to the settings, also the contents of archive files can be read and descriptions can be created automatically from some types of files.

You can scan a disk by the "Edit -> Scan disk..." command. The list of currently available disks is displayed and you can select disk to be scanned. The window with the list of disks is sizable. If you want to save the size of the window for the next DiskBase session, go to the Settings->Program Settings->Other and press the "Save current window and panel sizes" button. 

If you experience that before displaying this dialog box DiskBase checks the disks for a long time, read help about the "Do not read volume names for Scan disk dialog box" option that can be set in Program settings.

Note also, that you can select multiple disks to be scanned. By checking the "No queries" check box you can assure that DiskBase will not stop popping up any dialog box - this is useful for scanning large disks - you can leave your computer doing scanning unattended.

To scan the content of A: and B: disks, you can also use the "Edit -> Scan A:" or "Edit -> Scan B:" command, which is faster (the dialog box is omitted). Note that all these commands have Corresponding buttons on the toolbar and the Scan disk command has a key shortcut <F4>.

Note: In case you need just to start the DiskBase program, update disk in database and close the program, you might prefer to use the command line settings for the program. See Command line mode  chapter for details.

See also:

Disk name
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Rescanning a disk 
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Scanning a Disk 

Disk Name

Before starting the disk scanning process you must enter or confirm the name, under which the disk contents is to be stored to the database. As a default name DiskBase offers the volume label of the disk, if it exists. It is practical to have the volume label set on all disks (and written on their paper labels) when you want to update them in the database periodically: then before updating the disk in database you just confirm the name of the disk and thus avoid accidental overwriting of improper disk in the database. Having the disk name recorded in the volume label is also important for running DiskBase from the command line (automated database update) and multiple disks scanning without queries.

DiskBase compares the name you entered with the volume label and if they are different, you are offered to change the volume label on the disk to the disk name. Note that this feature is intended for replaceable disks only, so in case of fixed disk or network drive you will not get this possibility. Note also that this feature is implemented in the 32-bit version only; in the 16-bit version of DiskBase you must use File Manager or the Label command on DOS prompt to change the volume label.

The disk name in DiskBase can have up to 255 arbitrary characters; however if you are synchronizing the disk names with volume labels, you must keep on mind that there are certain limitations according to the disk file system:

--	On FAT systems is the maximum length of 12 characters (even in Windows 95 and NT).

--	On NTFS and HPFS the limit is 255 characters and you must have proper rights if you want to change it.

--	The limits on network drives vary according to the operating system; but you are usually not permitted to change it at all.

Each disk in the database must have a unique name (case insensitive, i.e. "My Disk" and "my disk" are considered as same). If you enter the name of disk already existing in the database, this disk is overwritten in the database (but still can be undeleted). You can set whether you should be warned about overwriting a disk or not in "Settings -> Database settings... -> Options" card (see the Program settings chapter for details).

When you are scanning series of disks, you might want to name the disks similarly, like "Project Alfa99, disk 3 from 8". For such case a possibility to define a template for disk name is available. See Program settings for details.

See also:
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Scanning a Disk 

Scanning the Contents of Archives

If enabled (in "Settings -> Database settings... -> Options"), DiskBase analyses the name of each file to determine, if it might be an archive or not. DiskBase is able to read the contents of most popular archive formats.

The file name must match one of the following strict masks in order the file to be read by DiskBase:

*.ZIP 	for ZIP archives created by PkZIP, WinZIP etc.

*.ARJ, *.Ann 	for ARJ

*.RAR 	for RAR

*.LZH, *.ICE 	for LhARC, LhICE, LhA

(where n is digit)

If the contents of an archive is successfully scanned, it is stored into the database and the archive file then looks like a folder in the database; you can look what is inside just by clicking on it, like on normal folder. If there are subfolders stored in the archive, these are displayed as folders under the archive folder.

It might happen that archive is not scanned successfully, because it is corrupted or it is just a non archive file accidentally having the name matching one of the masks above. In such case DiskBase simply skips this file, leaving it as normal file in the database; no message box is displayed.

All the scanning of archive files is done internally by DiskBase, without employing any external programs. As the archive formats are developing, it might happen that some formats will not be recognized properly in the future. If you find such case, please contact us; we will try to update DiskBase to a new format. 

In the List of supported archive file types chapter you will find a list of versions of archiver programs with which DiskBase was successfully tested.

Scanning Self-extracting Archives

DiskBase can also read the contents of self-extracting archives, created in ZIP, ARJ or RAR format. As the name of the executable file does not provide any information whether the file is a self extracting archive or not (and what kind of), its contents must be read and analyzed. This may increase the scanning time of a disk, if the disk contains a lot of executables. See the Program settings chapter for details.

Speed of Scanning the Archive

DiskBase must read the content of the archive file in order to find file names; however, the speed depends more on the number of files stored in the archive than on the archive file size. Some archives have a central directory, which can be read very quickly; ZIP is an example of such format (although some variations of ZIP format without the central directory also exist). On the other hand, reading the contents of the self-extracting archives is usually slower and thus increases time needed to scan the disk.

Time Saving Features

If the disk already exists in the database and you are scanning it again to the database, DiskBase scans the content of those archives only that were changed since last scan; the content of not modified archive files it copied from the existing disk in the database. This feature significantly saves time when you are scanning slow disks, like a floppy disk or CD-ROM. You might appreciate this feature namely with large CD-R, to which you are adding some data periodically and rescanning them then to a DiskBase database.

See also:
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Scanning a Disk

Rescanning a Disk

In case you use disk names that are different from the volume labels on the disks, the rescan of the such disks using the normal "Scan disk..." command is not very comfortable; each time you rescan it you would have to type in the corresponding disk name again.

For such case the "Edit -> Rescan disk..." command is useful. Before this command, select the disk in the left panel. Then it is usually enough just to confirm the dialog box, asking for name and path.

DiskBase remembers also the volume label of each disk and when you attempt to rescan a disk with a different volume label, you will get a warning: such case indicates that probably different disk is inserted in the drive, than is the disk you wish to scan.

See also:
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Scanning a Disk

Scanning a Folder as a Disk

You can also scan only a part of the disk - the selected and its subfolders. To do so, select the "Edit -> Scan folder as disk..." command from the menu.

Be careful with manually created descriptions in such case: If you change the folder when you are rescanning the disk, the manually edited descriptions can be lost.

See also:

Scanning a disk
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Window with Database

The database window is split to three panels:

--	Panel with disks

--	Panel with tree of folders and archives (can be hidden)

--	Panel with files and folders in the current folder

There is a header in the upper part of panels. You can change the width of each panel by placing the mouse cursor over the vertical border of the panel in the header (the cursor changes its shape) and dragging the border in required direction.

The header also indicates which panel is active by displaying a label in the active panel:

-- the panel with disks displays the database name�-- the panel with tree displays the current disk�-- the panel with files displays current folder (with path)

The active panel is the one that receives keystrokes from the keyboard. You can activate a panel by clicking by mouse inside the panel; also the <Tab> and <Shift-Tab> keys can be used to toggle between panels.

See also:
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Window with Database

Current and Selected Items

In the next text, two adjectives are used for items (=disk, folder, file etc.): current and selected. 

There can be one current item only (in the standard color scheme it is white on blue), however there can be multiple items selected (white on gray). Setting items as selected is used when copying, printing, deleting or exporting some (=selected) items from the list only.

The current item is changed by keys with arrows, <Home>, <End>, <PgUp>, <PgDn>, or by clicking with mouse on the item, which you want to make current.

You can use several ways to make an item selected: With the keyboard you can toggle selection by a spacebar, <Ins> key or by <Shift-Arrow> or <Shift-PgDn>, <Shift-PgUp> keys. With a mouse you can toggle item selection by clicking on it while holding <Ctrl> or you can select multiple items by clicking and holding <Shift>.

Note: This behavior is intentionally not fully corresponding to the standard Windows user interface, which is much less comfortable in selecting items.

Multiple Selection Using Wildcards

In the panels with disks and files you can also select multiple items using wildcards. The "Edit -> Select disks/files..." command brings up a dialog box, in which you can enter a (relaxed) mask for selection. The rules for mask creation are the same as in the search dialog box and are described in detail in the Using a search mask chapter. So here just briefly: the "a*" mask selects all files, which name begin with the "a" letter. 

You can also:

--	select all items by the "Edit -> Select all" command (<Ctrl-A> shortcut).

--	unselect all items by the "Edit -> Unselect all" command.

See also:
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Window with Database

Panel with Disks

The panel with disks shows the list of all disks in the database, sorted alphabetically. Change of the current disk automatically makes corresponding change in the other panels as well.

To select disks, use the actions described in the Current and selected items chapter.

In the panel with disks also the Copy and Print commands are available. See Copying to Clipboard and Print chapters for details.

Renaming a Disk

Disk in the database can be renamed by the "Edit -> Rename disk" command. However, when renaming a disk in the database, keep on mind that the difference between the name of the real disk (= its volume label) and the name of the disk in the database will cause that these two disks will be considered as two non-related disks by DiskBase.

Deleting and Undeleting a Disk

The disk (or multiple selected disks) can be deleted in the database by the "Edit -> Delete disk..." command. Deleted disks are preserved in the database until a compression of the database is made (see Database compression chapter for details). They can be undeleted if needed.

To undelete a disk, you first must enable display of deleted disks in the "Settings -> Database settings... -> Options" card. The names of deleted disks are displayed in square brackets and have a number added, which is making the name of the disk unique. Then you can undelete the current deleted disk.

See also:
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Window with Database

Panel with Tree

The default setting for the tree is a simplified display, i.e. not all the folders are shown, but just the top level folders. If there is a plus sign (+) in the graphical symbol of the folder, then there are some more folders hidden in this folder. You can display the content of such folder (=expand the branch) by double-clicking on it or pressing the <Enter> key while the folder is the current one.

By the same way you can hide the contents of the folder (=collapse the branch).

If you want to expand or collapse all branches of the tree, you can do that by clicking on the corresponding buttons on the toolbar. However, this setting is temporary; if you change the current disk, the tree is collapsed again. If you want to have the tree always expanded, check the corresponding option in the "Settings -> Program settings... -> Display" card.

The panel with tree can be hidden (by unchecking the "Settings -> Show tree" menu item); then more space is available for other panels. Hiding the tree panel also speeds up updating of the right panel when the current disk is changed in the left panel.

The tree can also be printed - see the  Print chapter for details.

See also:
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Window with Database

Panel with Files

shows a list of folders and files in the current folder. By double-click with a mouse on a folder name you can set the clicked folder to be the current one; equivalent is pressing the <Enter> key, which applies to the current folder.

The folder with two dots instead of name represents a parent folder, i.e. reference to one level up in the tree (closer to the root). So by double-clicking or pressing <Enter> on it means switching to one level up in the folder hierarchy. As an alternative, you can use the <Backspace> key as a hot key for switching one level up. Another alternative is a button on the toolbar.

List Appearance

The appearance of this panel can be set by "Settings -> Program settings... -> Display". A lot of these settings are duplicated directly in the "Settings" menu, so you can switch these options quickly, using also hot keys. Another alternative are the buttons on the toolbar.

When the detailed display is set, you can set sort order of the list also by clicking on the head of the column, according which the list is to be sorted (with the exception of the column with descriptions). The place where you click in the Name column header is sensitive: when you click on the left part, sort is made by file names, when you click on the right part, sort is made by file extensions. In all cases the folders are listed first (but this does not apply for archives that behave like folders).

If click on the same place second time, the sort order is reversed.

The descriptions are shown shortened to max. 255 characters in this panel and line breaks there are replaced by slashes. To show and edit the full description, call "Edit -> Description" (see Descriptions chapter for details), or press <F2> or <Ctrl-Enter>.

To select files, use the actions described in Current and selected items chapter.

In the panel with files also the Copy and Print commands are available. See Copying to Clipboard and Print chapters for details.

Opening Files

Similarly as in Windows Explorer, you can open a file by double-clicking on it with a mouse or pressing the <Enter> key (this feature is available in the 32-bit version only). DiskBase first checks the existence of the file; the displayed disk might not be currently present in the disk, or the file may be deleted, moved, renamed, etc., from the time the last update of the disk in the database was done. If the file is not found, an error message is displayed.

If the file is found, DiskBase calls the application registered for this file type in your Windows to open the file. If no application is registered for the file, DiskBase opens Windows Explorer with the folder, which contains the file.

The opening of files by mouse double-click or <Enter> key can be disabled by unchecking in Settings->Program settings->Other->Enable opening existing files. - see also Program settings. When disabled, you can still use an alternative way to open the files, which functions always: By holding the <Shift> key when double-clicking or pressing <Enter>, the file is opened. Moreover, if you do so on a folder, then instead of jumping into this folder in DiskBase, this folder is opened by Windows Explorer (provided that the folder exists).

Note that the <Ctrl-Enter> or <Ctrl>-double-click is a shortcut for opening the description.

When you press Enter or double click on a file that is in archive, DiskBase finds the name of the archive where the file lies and tries to execute the program associated with its extension.

Example: if you have file MyPhoto.bmp in file C:\Photos\Photos1.zip and press Enter on MyPhoto.bmp, then DiskBase will find that this file lies in the archive Photos1.zip and checks, if there is any program associated with the ZIP extension. If it is, it calls the program, otherwise it calls Windows Explorer.

If you want to open the archive, for example you have the Photos1.zip selected in DiskBase, you must hold <Shift> while pressing Enter or double-clicking, otherwise Diskbase will normally switch to subfolders.

See also:

Window with database 
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Window with Database

Status Panel with Subtotal Information

There is a status panel in the bottom of the database window. In the left part of it a subtotal information belonging to the currently selected folder is shown; in the right part a detailed information about the currently selected file is shown.

Subtotal information has the following form: x folders, y files, z MB. The numbers indicate that the currently selected folder (in the tree panel) contains x folders, y files and the sum of file sizes in this folder and subfolders is z MB (or kB or B). 

In case the folder (or its some of its subfolder) contains archive file(s), the subtotal information has a modified form: x/xa folders, y/ya files, z/za MB. The numbers before the slash have the same meaning as above; the numbers following the slash indicate unpacked data values -- they simulate situation that would exists, if you unpack all the archives in the folder and subfolders.

Note: This functionality was added to DiskBase in version 5.08. The information is collected during scanning the disk, so it is missing on disks scanned by previous versions of DiskBase. That is why it is not shown until you rescan the disk. However, if you call Compress database; then the disks data are recalculated and displayed correctly for all the disks in the database.

See also:
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Descriptions

Sometimes it is pretty hard to guess what is a file contents just from its name. Although Windows 95/98/NT enable using long filenames (supported in 32-bit version of DiskBase), the DOS 8.3 limit for file name length is still having its consequences.

This is one of the reasons why DiskBase offers to assign a piece of text as a description for each folder and file. A plain text, without any formatting (like using bold, italics, multiple fonts etc.) is used for descriptions - for describing the file contents and for searching purposes it is fully sufficient.

To create or modify a description for the current file or folder is very easy: when you invoke the "Edit -> Description" command, a window with a simple editor is displayed for writing or modifying the description. Furthermore, DiskBase also offers a possibility to create descriptions automatically, from file contents.

When the detailed display is set in the right database panel, the part of the description is also displayed there, in the rightmost column.

When searching for a file, DiskBase enables to search the text not only in names of files and folders, but also in descriptions. Usually, it is enough to put a few keywords describing the file content into the description; then it becomes very easy to find the proper files in the database by searching a keyword.

Manual creation of descriptions

Automated creation of descriptions

Disk description



Descriptions

Manual Creation of Descriptions

Creating descriptions manually is simple and straightforward, but you should understand how DiskBase is dealing with descriptions when a disk content in database is updated by scanning the disk contents again. The procedure is as follows:

When scanning a disk into the database, DiskBase first verify whether a disk of the same name already exists in the database. If so, then during the scanning process a verification is made for each file, whether the file of the same name in the same folder exists and whether it has a description. If so, the description is moved to the currently scanned file. By this mechanism is assured that the descriptions are not lost when you scan the disk into the database again. 

However, there are cases, when DiskBase is not able to verify the existence of the original description:

--	when you decide to save the disk into the database under a different name (if you want to preserve descriptions in such case, you must first rename the disk in the database to the name you are going to use).

--	when the file with a description is on the real disk�- moved to another folder �- or moved to another disk,�- or renamed,�- or the folder, which contains the file is renamed or moved.�In such case there is no solution how DiskBase can find the proper description when scanning the disk again and the description is lost. 

--	when you first delete or rename the original disk in the database and then scan the disk into the database.

If you avoid such cases, you can use descriptions successfully. Avoiding it is easy namely in case of media, that you are scanning only once to the database, like CD-ROMs. 

On rewritable media it is safer to use Automated creation of descriptions as then you cannot accidentally loose any of them.

Note also, that once you start write descriptions manually to the database, it is recommended to start making backup copies of the database. If you accidentally loose the database without manually edited descriptions, you can easily create a new one just by rescanning all the disks to a new database, but with manually edited descriptions you input unique work into the database, which is should be backed up.

See also:

Descriptions
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Automated Creation of Descriptions

Let's start with an example: There is a lot of sample programs on the MS Developer Network CD-ROMs and there is a convention to place each sample to a standalone folder and add a text file called "Abstract.txt" to the folder. This file contains a brief description of the sample and thus it would be good, if the text of this file was transferred to DiskBase database as a description of the folder. Then searching for some sample in heap of CD-ROMs can be easy (this example is just illustrative; there are actually other searching tools available on the MSDN CD-ROMs).

DiskBase is able to copy the text from a file to its description. To make it, the file name must match one of the (strict) masks set in the list of rules the "Settings -> Database settings... -> Descriptions". You can find detailed explanation about masks in the Using a search mask chapter)

This can be utilized in two main ways:

--	by creating text files on disk for the purpose of being a description

--	by copying contents of existing files of various types

The first possibility can effectively replace manual creation of descriptions made directly in the database in case you want to describe the whole folder rather than one file. This is very common case; usually you organize files, that are related, into one folder and you usually do not search for a single file, but for a folder with files. You can decide for some unified name that you will use for descriptions, like "Info.txt" or "Contents.txt", create such file in every folder and write keywords describing the contents of the folder (using some plain text editor like Notepad). Then, if you specify this name as a mask in the descriptions settings (list of rules), the contents of these files will be copied to the DiskBase database. The advantage is that you can move the folder anywhere or rename it without loosing the description (as is mentioned by the manual creation of descriptions).

The second possibility means that you can read a part of a file, which was not originally created for the purpose of being description, but is at least partly suitable for it. Typical examples would be files like "ReadMe.txt", "Abstract.txt", "FileDesc.id" etc. 

Another typical example would be reading a part of document written in some word processor. But this case is bit more complex: Word processors, like most other programs, store beside the text a lot of other (usually binary) data into the file; these data should not be copied into the description, because they do not provide useful information for description (for example tags in the RTF format) and if they are binary, they look like a heap of random characters (for example a bitmap in a document). DiskBase provides a solution to this problem: you can use a filter that makes a conversion from the specified file format to a plain text.

Filters

in DiskBase are not part of the program itself, but are appended to the program as plug-ins. The advantage of this solution is that if you know a bit about programming, you can create your own customized filters (see the Creation of conversion filters chapter for details). 

The following standard filters are available in DiskBase:

HTML	extracts text from the HTML format

RTF	extracts text from the Microsoft Rich Text Format

Uni	universal filter: it tries to find text in a binary file with unknown data structure. It can be used for files like *.wri, *.doc, *.xls, etc.

MP3	extracts tag (title, artist, album, genre, comment) and some parameters (bit rate, sampling frequency) from audio files in MPEG3 format.

MP3Tag	extracts just the tag in form of one line.

Universal filter

was created because there is a huge number of data file formats and it is not possible to cover them all in DiskBase. Moreover, their data structures are most often not published, so it is usually impossible to write the properly functioning filter for such files.

The Uni filter employs a bit of heuristics to find a text in a file. The result text usually contains some percents of characters, that are not a valid text, and on the other hand it may not recognize all the valid words in the file; however, the result text might be still sufficient for the purpose of searching and getting a rough information about the file contents.

The Uni filter also reads the text in Unicode, but without accented characters.

Description Size Limit

You can set the size limit for the text copied from a file to the description. Usually 500 characters is enough for storing information suitable for search (for illustration: 1000 characters corresponds to about a half page of typewritten text). When you increase the limit to a higher value, keep on mind than the DiskBase database can then grow fast to a pretty large file.

Extraction of Descriptions from ZIP Archive Files

If the file with potential description is stored inside an archive file, then the description cannot be read directly; the file must be extracted from the archive first. DiskBase is able to do so for archives of ZIP type. Extracting descriptions from archives prolongs the time of scanning, so this feature is optional. It can be disabled by unchecking the "Extract descriptions from ZIP archives" check box in Settings -> Database Settings -> Options. 

The same rules as for normal files apply also for files in ZIP archives.

Note that in some cases the "Always rescan archives" option should be checked too - see Database settings for details.

Rules for Automated Description Creation

are represented by a list in form: Mask - Size limit in characters - Filter. When scanning a disk, DiskBase compares each file name with all the (strict) masks in this list; if some file name matches some of the mask, the content up to the specified size limit is read to the description, using the specified filter.

An example of such rules is shown below:

Mask	Size limit in bytes	Filter

info.txt	1000	

readme.txt	2000	

abstract.txt	500	

*.txt	200	

*.doc	200	Uni

*.sam	500	Uni

*.rtf	500	RTF

*.htm	200	HTML

*.html	200	HTML

*.mp3	130	MP3Tag

This list of rules can be set in the "Settings -> Database settings... -> Descriptions" card. See also the Database settings chapter. Note that you can set no filter for a rule; then just copying of the file to the description is done, with removing of non-printing characters.

Manual Modification of Automatically Created Descriptions

Finally it is necessary to explain what happens if:

--	you manually modify an automatically created description and then rescan the disk

--	you manually create a description to a file, that later on matches some rule for automated creation of descriptions.

In both cases the priority always has the manual work; files with manually modified descriptions are excluded from the automated creation of descriptions.

See also:

Descriptions
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Descriptions

Disk Descriptions

A description for a disk can be created in the same way as folder and file descriptions are done. A file name DiskInfo.txt in the root folder is reserved for disk descriptions. The file of this name is automatically placed as first to the list of folders and files regardless of sort criteria set, so it is always visible when browsing through the database.

The common way to create a disk description on a disk is to create a text file named "DiskInfo.txt" in the main (root) folder of a disk. If you have the rules for automated description creation set to read the contents of this file, then the disk description is read from this file by DiskBase as any other automated description.

However, in case you want to write down such description directly into the database (for example in case of archiving read-only media like CD-ROM), DiskBase can create a simulated file in the disk root folder, so you can edit its description. To let DiskBase to simulate it, check the "Simulate disk descriptions" check box in "Database settings". 

DiskBase adds this simulated file when scanning a disk to the database; in case a real file of this name exists, the simulated one is not added.

See also:

Descriptions

Manual creation of descriptions

Automated creation of descriptions



Searching in the Database

Searching is sequential in DiskBase, i.e. the program goes through all the file and folder names and descriptions to find the searched text. The time needed for search is thus dependent on the database size; it is also dependent on the complexity of searching criteria: for example searching just in file and folder names is faster than searching in both names and descriptions.

Using a search mask

Searching files

Searching selected files

Window with found files

List of free space

Window with the list of free space



Searching in the database

Using a Search Mask

The mask is usually the main criteria for searching. DiskBase compares each file or folder name with the mask and if the name is matching the mask, the file is put to the list of found files. Similarly it works with descriptions. 

Let's start with a few examples:

Mask	means (i.e. the name will match the mask in case of)

invoices	file that contains the "invoices" word in its name,�for example "Unpaid Invoices April99.xls"

*.txt	file with any name where the ".txt" string occurs,�for example "Read Me.txt", "What's New.txt.lnk", etc.

a*	file, in name of which some word begins with the "a" letter,�for example "Antology.doc", "Value added tax.xls", etc.

backup??.*	file, in name of which is a 8 characters long string, that begins with the "backup" word followed by two arbitrary characters, followed by a dot and arbitrary text,�for example "Backup09.dat", "My backupA1.tre", etc.

As you can see from the examples, an asterisk (*) and a question mark (?) have specific meaning (they are referred as wildcards ): 

The asterisk means: on this place any number of any characters can occur (including no characters).

The question mark means: on this place just one arbitrary character must occur.

The above described mask is called Relaxed type in DiskBase (see also Strict type, described below). The relaxed means that other text, separated by non-letter characters (space, dot, comma, semicolon etc.) can be present around the found text. This means that for example the mask "guitar" will match a text like "Playing flamenco guitar is not easy.", but will not match a text like "They use GuitarPro software for notation.", because after "guitar" is not a non-letter character - in such case you would have to search for "guitar*".

Usage of the Asterisk Wildcard

The wildcards usage is a bit similar to conventions used in the old DOS file system - you might be familiar with it. However, there was a limitation in DOS file names that asterisk could be placed at the end of mask only. In DiskBase there is no such limitation; you can use asterisk on multiple places in the mask. 

The same mask is used for both searching in names (of files and folders) and searching in descriptions.

Example: With the mask *author* the words like author, unauthorized, authoring, authoritative, authorities, authorship, etc. will match.

Another difference is that DOS distinguished name and extension as two independent parts of file name. You might expect that the mask with which any file will match is "*.*". But this is not exactly true in Windows 95/98/NT, where a dot (.) is treated as any other character and need not necessarily be contained in the file name, so in fact this mask would match all files, which contain at least one dot. The right mask to match any name would be simply one asterisk: "*".

This difference leads to one frequent misunderstanding, that can be illustrated on the following user's question: I have a folder called "Orders" on my disk, but DiskBase does not find it when I specify the "Order*.*" mask. The reason is simple: The "Orders" folder does not have any dot in its name and thus it does not match the masks "Order*.*". The correct mask is "Order*".

Multiple Masks

You can specify multiple masks for searching just by writing them separated with space. 

Example: a* b* c* are three masks and all files containing words that begins with letter a, b or c will match this multiple mask criteria.

Multiple Word Phrases in one Mask

As space is considered as a separator of multiple masks, how can a multiple word phrase, like sales department be searched? The solution is in using quotation marks (") around masks, containing spaces.

Example: When searching a computer science phrase, then, if you write it as "computer science" (including the quotation marks), the phrase is correctly searched, but if you do not use the quotation marks, the all the names and descriptions containing the word computer and all the names and descriptions containing the word science will be listed.

You can use wildcards in phrases too; the quotation marks just determine actual begin and end of the mask. If you want to search for quotation marks, you must write them doubled. 

You can combine masks surrounded with quotation marks with masks not surrounded arbitrarily.

Strict and Relaxed Mask Types

As was already mentioned, you will meet the mask in two forms in DiskBase: the Relaxed mask type and Strict mask type. 

The Relaxed type (described above) is used for searching in the database and functions as described above.

The Strict mask type has only one difference: Unless you explicitly place an asterisk at the begin and/or end of the mask, no text is permitted to be there. Let's demonstrate this on some examples: 

When the mask is "author", the relaxed mask would match with text like: "The author of this composition is Paco de Lucia.", but the strict mask would not match this text, as there is other text around the "author" word. 

When the mask is "author*", the relaxed mask will additionally match with sentences like "Special tools called authoring systems, are...", or "Authoritative behavior...".  The strict mask will not match the first example, but will match the second one, because it matches with any text, that begins with "author".

As you can see, in the strict mask you can specify, that the text must begin (by not using an asterisk at the begin of mask) or must end (asterisk not at the end of mask) with some word. This is not possible in the relaxed mask type. The strict mask is suitable namely for more exact specifications of the file or folder name. For example, when you want to specify that searched files must be in folder named "Music archive" only, you specify the "*\Music archive" mask in the Search only in folders option (see the next topic) - then the files will be searched in folders like "\John\violin\music archive", "\Flamenco\Music archive", but not in "\Music archive\tablatures".

In DiskBase the relaxed mask type is used for 

-- specifying mask for search in the database (unless there is the "Strict mask" checked)�-- specifying mask for files to select disks or files in a list

The strict mask type is used for 

-- specifying the rules for automated extracting of descriptions�-- "Exclude file" option in More Options for Search�-- "Search only in folders" option in More Options for Search

See also:
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Searching in the Database

Searching Files

To search files you must enter criteria for it in the dialog box, that is displayed after calling the "Search -> Find files..." command. This dialog box has the following items:

Search text

One or more relaxed masks are to be entered here (see the Mask chapter for details about masks). When you are repeating search, you can select form the list already entered masks, by clicking to the button with arrow right to this edit control.

Go through

You can set which part of database should be searched in:� -- the whole database� -- current disk� -- selected disks� -- not selected disks

Find text in

- file names�- folder names�- descriptions

Search also as parts of words

When you check this option, the asterisk characters are added automatically around the words, so all words containing the specified parts will be found. See also Mask.

Search as phrase

When you check this option, quotation marks are added around the phrase you wrote - this is suitable for example for searching files with space in their name, like "Program files". See also Mask.

Search only in:

� unlimited�� the root folder�� subfolders down to 1. level�� subfolders down to 2. level�...

Here you can set the limit for folder level, in which the search to be done. For example "subfolders down to 1. level" means that search will be done in the root (main) folder and its first-level subfolders, but not deeper.

Case sensitive comparison

If checked, upper and lower case of the same letter (e.g. A and a) are considered as different letters when comparing the text with masks.

Strict mask

If checked, the strict mask type is used for searching in file and folder names. See Mask for details about the strict mask type.

Stop search after n files found

You can set a limit for a number of found files. By setting this limit you can avoid creation of very large list when you accidentally set too wide criteria to which too many files are matching.

Use more options:

If checked, additional conditions specified in a separate dialog box are used for search.

More Options

By pressing this button, you can display another dialog box with more options for the search, that are not used very often, but sometimes might be suitable.

Exclude files

Files and folders with names and descriptions that match strict masks entered here are not put to the list of found files. The mask is case insensitive.

Example: You are searching for text files with the "*.txt" extension, but do not want to list files called "readme.txt" and "abstract.txt", so you put readme.txt abstract.txt mask to this edit control.

File date must be from ... to ...

Sometimes it might be suitable to have possibility to search for file, which was last modified in certain time period; for example you are searching for some document, but you have no idea what name it had, but you know, that you were certainly working with it in December of the last year. Then you specify just the search mask "*.doc" and the dates in this dialog box.

You can also have only one time limit set (checked by the check box), so you can search for files not older than certain date, for example.

File size must be from ... to ...

Similarly as in previous case, you can set a range of sizes in kBytes, which the file must match.

Search only in folders:

Here you can specify a strict mask which the path to the file must match in order the file to be listed as found. 

Examples: 

"*samples" - will search in folder, where on the end of the path is the "samples" word, for example \Archive\Delphi2\Samples, \Msvc16\MFC\Samples, etc.

"\Program files" - will search just in the "Program files" folder.

"\Program files*" - will search in the "Program files" folder and its subfolders.

The mask here is always strict and case insensitive.

Sort found records by

Three sort keys can be set; the second one is used for comparison of two items when the first one is the same; the third one is used when the second one is the same. The sort order can be changed also later on, when the window with found files is already displayed, by clicking on the column header.

Search as ANSI text

When checked, the text in descriptions is considered to be in ANSI encoding. This is default setting. See the next paragraph.

Search as OEM text

When checked, the text in descriptions is considered to be in OEM encoding. OEM encoding was used in DOS - the difference between ANSI and OEM encoding is not significant in English language, but is significant languages containing additional characters, like characters with accents and diacritics. For these languages the encoding in DOS (referred as OEM) and Windows (referred as ANSI) is different. Unfortunately, there is no universal way, how to detect the encoding in text files, so the text in automatically created descriptions may be in various encodings.

When this option is checked, DiskBase will convert the text from each description from OEM to ANSI encoding before doing the comparison. Thus, the text can be searched also in descriptions, which are in OEM encoding. Note that this option slows down the search speed partially.

See also:
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Searching in the Database

Searching Selected Files

By the "Search -> Find selected files" command you can start immediate search without filling the Search dialog box. As masks all the names of selected files (including the current one) are used. Typical usage of this command is when you want to know "where else do I have the same files?"

See also:
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Searching in the Database

Window with Found Files

is divided into 6 columns: Disk, Folder, File, Size, Date and time, Description. You can change the width of any column by dragging the vertical edge of the column header. The actual width of the column is then also used for printing.

If you double-click with mouse on a found item, the DiskBase switches to the window with database and displays the file or folder there. The same action can be made by pressing the <Enter> key, which is applied to the current line. You can switch back to this window by using the "Window" menu, corresponding button on the toolbar or the <Ctrl-Tab> or <Ctrl-Shift-Tab> keys.

The lines in the list can be selected using the same method, as was described in the Current and selected items chapter. Selecting lines makes sense for copying to Clipboard and printing. See Copying to Clipboard and Print chapters for details.

You can change the sort order of the lines by clicking on the header of any column (with the exception of the Description column); then the lines are sorted by the content of the column.

See also:
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List of Free Space

By the "Search -> List free space..." command you can create a list of all disks, each with information about total size and free size. The sort order can be set by clicking on the column header in the window with the list.

See also:
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Window with a List of Free Space

is divided into 4 columns: Disk, Size, Free space, Free space in %. You can change the width of any column by dragging the vertical edge of the column header. The actual width of the column is then also used for printing.

If you double-click with mouse on a line, the DiskBase switches to the window with database and displays the corresponding disk there. The same action can be made by pressing the <Enter> key, which is applied to the current line. You can switch back to this window by using the "Window" menu or the corresponding button on the toolbar or the <Ctrl-Tab> or <Ctrl-Shift-Tab> keys.

The lines in the list can be selected using the same method, as was described in the Current and selected items chapter. Selecting lines makes sense for copying to clipboard and printing. See Copying to Clipboard and Print chapters for details.

You can change the sort order of the lines by clicking on the header of any column; then the lines are sorted by the content of the column.

See also:
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Information about Disk, Database

Disk Information 

dialog box can be displayed by the "Search -> Disk information..." 

Disk:	Name under which the disk is stored in the database.

Volume label:	Volume label of the disk (physically stored on the disk).

Original path:	The drive letter assigned to the disk, when it was scanned, and the path in case a folder was scanned as disk.

Total folders:	Total number of folders on the disk. Folders inside archives are not counted.

Total files:	Total number of files on the disk. Files inside archives are not counted.

Total archives:	Total number of files, which were successfully recognized and scanned as archives.

Sum of physical file sizes:	Sum of sizes of all files found on the disk (not including files in archives).

Disk size:	Disk size as it is reported by operating system (in the 16-bit version an incorrect value of disk size and free space is sometimes reported by the OS for CD-ROMs). In Windows 95 first version the size of disks larger than 2 GB is also incorrect, as it is incorrectly reported by the operating system.

Disk free size:	Disk free space as it is reported by operating system.

Total files in archives:	Total number of files in successfully scanned archives.

Total folders in archives:	Total number of folders in successfully scanned archives.

Sum of file sizes in archives:	Sum of sizes of all files in archives.

Total data size:	Calculated as Sum of physical file sizes + Sum of file sizes in archives - Sum of sizes of archive files. In other words the data size corresponds to an imaginary situation when you unpack all the archives to the disk and then delete all the archive files.

Last update:	The date and time when the disk was last scanned.

Database Information 

dialog box can be displayed by the "Search -> Database information..." command.  

Database:	Name of the file with the database (without the QDR extension).

Size:	Current database size.

Total number of records:	Total number of disks stored in the database.

Number of deleted records:	Number of deleted disks in the database (recall that a disk is always deleted when you rescan it).

Compression recommended:	This value is derived from the ratio of deleted disks and total number of disks; however, you can do the compression even if it is not recommended. Compression just release the unused space and does not have any other significant influence to the database functionality.

Read-only:	Indicates whether the database is of Read-Only type. 



Program Settings

The Program Settings dialog box can be displayed by the "Settings -> Program settings..." command. Here you can change settings that are related to the program itself, regardless of a database currently open. The dialog box has three cards:

Display

This card is concerned on settings how the contents of the three panels in the database window is displayed.

Show tree: if not checked, the panel with tree is hidden. Hiding the tree speeds up the program response when you change the current disk.

Show (tree) always expanded: if checked, all the tree branches are always displayed.

Sort files by: (name, extension, date and time, size) - sets the sort order of files in the panel with files. Folders are always put to the beginning of the list, however, this does not apply to archives, which otherwise look and behave like folders.

Display files:

Names only, in columns: only names with extensions are displayed, the rest of the file information is available for the current file only in the bottom status bar of the window.

With details: you can check which columns are to be displayed (with size, with date and time, with description). 

File size display:

in bytes: i.e. as long number

in kB, MB: i.e. for sizes under 1 MB the size is displayed in kBytes, over 1 MB is displayed in MBytes. 

Show icons by folders: this applies to the panel with files; by hiding the icons you can save some space and make the display of the list faster.

Time with seconds: if not checked, only hours and minutes are displayed (this apply also for printing).

Use Windows date format: if checked, the short date format that is set in Windows Control Panel is used for displaying the date.

Calculate: 1 kB = 1024 bytes: If checked, then the following arithmetic for kilo- and mega- is used: 1 kB = 1024 bytes, 1 MB = 1024 kB. If not checked, then 1 kB = 1000 bytes, 1 MB = 1000 kB. This setting is used for all size values displayed in DiskBase.

Show hints by files: If checked, then a bubble with file details is displayed when you position a mouse cursor over a file in the File Panel. The bubble disappears whenever the mouse is moved. In case the "Names only, in columns" display is set, then the bubble contains information about the file name, size, date and part of its description. If the detailed display is set, the bubble appears only in case the file has a description. Part of a description is displayed in a bubble also in the window with found files.

Fonts

Fonts used in child windows and panels can be set on this card. 

Print

Print font: here you can set the font used for all printouts. 

Header text for print: If set, it is printed in the header of each printed page; if empty, DiskBase uses a default header (according to print type).

Page margins: Are counted from the edge, from which the printer is able to print (which need not be equal to real paper edges by some printers).

Adjust name column width: When printing the contents of the database, DiskBase first checks the width of each file name in the folder and sets the column width so all the file names fit in it. However, this can sometimes lead to very wide columns just because one file has a very long name, while other files in the folder have short names. By checking this option, you can instruct DiskBase to do a bit statistics on file name lengths and determine the column width from an average name width rather than from the maximum one.

Other

Open database at startup: If you enter the database name here, the database is opened automatically at program startup. The name must be specified with full path and extension; best way how to do that without a mistake is to use the "Browse..." button. This option is disabled when the "Open last opened database at startup" is checked. Note that when you change this option you should save the settings.

Open last opened database at startup: If checked, DiskBase automatically opens the database that was opened (and on top), when DiskBase was closed last time. Note that in the "File" menu the list of recently opened databases is available.

Save settings automatically at program end: When checked, then the current settings are always stored to the initialization file, which is read at program startup. This requires the folder with the program be available with read-write access. Compare this option with the "Save" button functionality.

Each search to a new window: If checked, the recycling of windows with lists of files is not used, so when you make a search for files, the output of this search is made to a newly created window. This settings applies to the window with found files only (does not apply to the window with the list of free space, which is always recycled).

Make backup copy when compressing database: if checked, the original database is saved under the same name with extension modified to ".~QD" when making the compression of the database.

Do not read volume names for "Scan disk" dialog box: Normally DiskBase always scans all disks for their names before the "Scan disk" dialog box is displayed, in order to update the list of available disks in the system and their names. Usually, this does not cause any problem, but in special cases (e.g. when using a CD-ROM changer) the reading of volume names can take a pretty long time. When you uncheck this check box, the volume names will not be scanned and you will see just drive letters (A:, B:, C:, D: ...) in the "Scan Disk" dialog box.

Enable opening existing files: If checked, then files in the file panel can be opened by double-click or pressing Enter (like in Windows Explorer) - provided that the file physically exists on accessible disk. If not checked, the function is still available when you hold the Shift key while double-clicking or pressing Enter. See also Panel with files.

Save current window and panel sizes:

By pressing this button the current window size of the program and state of the main and child windows (= normal, minimized or maximized) are saved to the INI file, belonging to the program. Also the widths of the panels in database window and the "Scan disk" dialog box size are saved. These values are then used at program startup.

Example: If you prefer to have DiskBase maximized over the whole screen at startup, maximize the main window, then display Program Settings dialog box and press this button.

Save button

By pressing this button all the settings from this dialog box are saved to the initialization file, which is placed in the same folder in which the program is placed. The file has the same name as the program, but the ".ini" extension. DiskBase is reading the settings stored in this file at its startup. The folder with the program has to have a read-write access enabled, otherwise the Save button will not function.

See also:

Database settings



Database Settings

The Database Settings dialog box can be displayed by the "Settings -> Database settings..." command. Here you can change settings that are related to the currently open database. The settings are stored to the database. The dialog box has three cards:

Descriptions

See also the Descriptions chapter for information about descriptions themselves.

Read descriptions: if not checked, no descriptions are read even if the rules for them are set.

To decide whether to read a part of file into its description, a list of rules is used. The list has three items in each rule: Mask, Size limit and Filter. If the file name matches the mask (strict type), then its contents up to the size limit is read into the description, using the specified filter. 

To add an item to the list you first have to enter proper values to the three fields on the left and then to press the "Add >>" button.

You can delete items in the list by pressing the <Del> key.

You can modify an item by moving it to the fields on left side by pressing the "Remove <<" button, modify it and then add it back to the list by pressing the "Add >>" button.

The order of rules is significant in the list; the comparison is made in direction from the first to the last rule until a matching rule is found. 

Example: When you specify a rule with "readme.txt" mask after a rule with "*.txt" mask, the rule with the "readme.txt" mask can never be matched, because all the files with the ".txt" extension are catched by the "*.txt" rule. But if you specify them vice versa, then you can process "readme.txt" files with other rule (other filter or length) than other ".txt" files.

You can move items in the list by dragging the left (gray) part of the line with a mouse.

See also Automated creation of descriptions for information about filters.

Archives

Scan archives

- yes, without prompt: DiskBase will try to find out the contents of an archive file in case its name matches some of recognized archive types. See the Scanning archives chapter for details.

- yes, with prompt: before scanning the contents of the file a dialog box is displayed and you can decide whether to scan it or not.

- no: Scanning a disk will be significantly faster, but you will not have any info about archive contents. 

Scan self-extracting archives of ZIP type: the files with the exe extension are analyzed whether they contain compressed data in the ZIP format. The last 32 kB of the file is checked and if the central ZIP directory is found there, the contents of the archive is put to the database. 

This scanning is faster than the second method, that can be switched on by the option below. If both this option and the option below are switched on, then DiskBase first checks, if it can read the contents of the ZIP file quickly, and if not it uses the slower method described below.

Scan self-extracting archives of ZIP, ARJ and RAR types: the files with the exe extension are analyzed whether they contain compressed data in the ZIP, ARJ or RAR format. The first 64 kB of the file is analyzed (including the ZIP format, so non-standard ZIPs without the central directory can be detected here too). 

Analyzing the contents of exe files adds some overhead time for disk scanning. This is the reason why scanning of self-extracting archives is made as an option.

Always rescan archives: If checked, then the contents of archives is always rescanned when the disk is scanned. If not checked and the disk is already in the database and an archive is unchanged, then the contents of the archive is copied from the previous disk image instead of scanning it again - this feature saves time (namely on slow media, like floppy disks).�Normally you should leave this check box unchecked - but there are some cases when you may need to check this option. Typically, when you enable the "Extract descriptions from ZIP archives" and have already some ZIP files stored in the database (without descriptions extracted), then without checking this option, the descriptions would not be extracted for the unchanged ZIP files, which are already stored in the database. As having this option checked prolongs the time needed for scanning, it is recommended to have this option turned on only temporarily.

Extract descriptions from ZIP archives: If checked, then files matching a mask for automated description creation are extracted from archives of ZIP type, in order to be read as descriptions. Unpacking is made to a temporary file, which is deleted after the description is read, so the process of unpacking does not require any attention from the user. Having this option checked enables to extract descriptions from files like File_Id.diz, which are typically stored inside an archive. Of course, extraction of files from archives slows down the scanning of the disk significantly.

Options

Warning before overwriting a disk in database: if checked, a warning displayed if you try to scan a disk to the database and a disk of the same name in the database already exists. This setting is ignored when the program is run with command line options. See the Command line mode chapter for details.

Do not offer volume name change: When checked, DiskBase will not ask you if you want to change the volume label also on disk, when you enter a different disk name before scanning the disk. Thus you can avoid accidental unwanted change of the disk volume label.

Template for disk name generation: If you specify the template here, the disk name created from this template will be offered to you before scanning the disk. The template is a line of text, which can contain two special symbols: #N and #D. #N is replaced by a number, that is increased by 1 after each scan. #D is replaced by the actual disk name.

Using the template you can easily create series of names, like "Excalibur 99 - 1/12", "Excalibur 99 - 2/12", "Excalibur 99 - 3/12" etc., by using a template "Excalibur 99 - #N/12". The Reset counter button resets the number to 1.

When the template is defined, the button "Use generated" appears in the dialog box for entering the disk name before scanning the disk.

Display deleted disks: If checked, the deleted disks are displayed at the end of the list in the left panel. The names of deleted disks are in square brackets. Even if displayed, the deleted disks are ignored when searching in the database. The main purpose of displaying the deleted disks is to enable the Undelete disk function.

Simulate disk descriptions: Even if a file with the name DiskInfo.txt is not found in the root directory of the disk, it is still placed to the disk record in the database (i.e. it is simulated in the database, as if it was found on disk), so you can then create disk descriptions. 

Always recreate descriptions from files: The only case you need to switch on this option is when you change the rules for creating descriptions by filters or if you change the filters. Normally, once the description for the file is created by a filter, it is not created again the next time the disk is scanned unless the file date/time and size changed since the last description creation. This speeds up the scanning progress. By checking this option you can force DiskBase to create the descriptions again every time the disk is rescanned.

See also:

Program settings



Copying to Clipboard

The following items can be copied to the Clipboard

--	selected disks in the panel with disks (in the window with database)

--	selected folders and files in the panel with files (in the window with database)

--	selected files in the list of found files

--	selected lines in the list of free space

When copying disks and folders, just the names are copied, not the contents.

In lists where multiple columns are displayed are their contents separated by the tab character. If you are then pasting the list into a word processor, it is easy to use the tab characters for text formatting. Also most spreadsheet programs (like MS-Excel) can preserve columns when such text is pasted into them.



Print

The "File -> Print..." commands enable to print various parts of the database. The Print button prints contents of the top window - and in case of database main window the selected panel.

Some print settings (header text, margins, fonts) can be found in the "Settings -> Program settings -> Print and other" card. Before sending data to the printer the standard Print dialog box is displayed, in which properties like printer, number of copies, paper orientation etc. can be set.

For some prints it is suitable to set the landscape orientation and use some narrow font in order to fit all the columns to the paper.

You can print either all items or selected items (the "Print selection" option in the dialog box).

Printing the list of found files

Note that the widths of columns in the window are used also for printing, so it is recommended to set the column widths first, according to your needs.

Printing the tree

The tree is printed in several columns in order to save paper. If you set "Print selection" option in the Print dialog box, only the current folder with its subfolders (a branch) is printed. 

Note that the tree is printed in columns to save space - but in case a folder with very long name exists in the tree, it can cause that only one column will be on one page, as the column width is calculated from the longest name.

Printing a part of the database

If you select print from the left panel with disks, the most complex print is done: Each disk in the database can be printed with all the files it contains. Only the current disk or selected disks can be printed (this limitation is intentional, as printing the whole database could mean even thousands of pages). Before printing the dialog box for print options is displayed:

Print:�  -- this disk - current folder�  -- this disk - whole�  -- all the selected disks

DiskBase first calculates expected number of pages an in case the number is high, it displays a prompt whether you are sure to print them all. The sort order of files is determined by the setting in Settings -> Program settings -> Display. 



Database Compression

With each change in the database the size of the database grows. For example, when you scan a disk to the database, the old disk of the same name in the database is not overwritten, but just marked as deleted (so it can be undeleted if needed), and the new one is stored physically at the end of the database, increasing the size of the database.

So it is important to remember to make a database compression from time to time. The compression copies the content of the database into a new one, skipping all the deleted items in the database, so the database then occupies less space on disk.

The compression can be executed by the "File -> Compress database..." command. Then you select the database which is to be compressed. The database must not be open if you want to compress it. The compression might be a lengthy process, it can take even a few minutes, depending on the database size and the speed of your computer.

By the "Settings -> Program settings -> Print and other -> Make backup copy..." option you can decide whether the original database is to be saved for backup purposes. 

See also:

Repairing the database

Exporting the database

Exporting database to other formats

Creation of read-only database

Importing the database



Repairing Database

This command can be used to repair corrupted database. The repair command searches in the database for disk labels, so it can recreate the key index. Then it copies the database, leaving out all unreadable parts. 

It is important to know, that the repair of the database does not recover the corrupted data; it just excludes them from the database, so the database can be used normally again. This implies, that you should backup your database regularly, namely in case you have a lot of manually created descriptions inside (this is also reason why automatically created descriptions are better - if you loose the database, you can at least create it again by scanning your disks again).

See also:

Exporting the database

Exporting database to other formats

Creation of read-only database

Importing the database



Exporting Database

The meaning of the export word here is creating a new database and copying the selected disks into it from the current database. The export can be executed by the "File -> Export..." command. 

By using export you can easily split a database into several databases or you can move disks from one database to another by doing export to a temporary database and then import from the temporary database to the target database.

Export from the read-only database is not enabled.

See also:

Exporting database to other formats

Compressing the database

Repairing the database

Creation of read-only database

Importing the database



Exporting Database to Other Formats

DiskBase enables to export the database data or the lists of found items to various text formats. These formats can be either used directly (e.g. the HTML format), or as import formats to other applications (delimited formats).

The definition of the export format is specified in the DiskBase Export Format files (*.defX) - these files are text files and can be modified by any plain text editor (like Notepad), so you can either customize existing formats or create new ones, for your specific purposes. See Writing your own export format for details. 

To export the database or the list of found items, use the "File->Export to other format..." command. Three steps are needed to run the export:

- select what to export (similarly as when printing),�- select export format definition file,�- set the output file name, to which the exported data will be written.

There are 3 types of export format definition files available:

- for exporting the items from the database,�- for exporting records from the list of found files, and �- for exporting records from the list of free space. 

To distinguish the files with export formats, three different extensions are used for Diskbase Export Formats: *.defd (for Database), *.deff (for Files) and *.defs (for free Space). Yes, the extensions are 4-letter long instead of usual 3 (why not - it is permitted). Depending on the type of the export, DiskBase offers the list of files with the corresponding extension. For example, when exporting from the database, you will see the list of "*.defd" format files, like "HTML Brief.defd", "Leveled - tab delimited.defd", etc.

DiskBase comes with several predefined export formats - here are some of them:

Plain - semicolon delimited with quotes.defd

This format exports the database in a plain format, i.e. all the export lines have the same format, in form of:

"Disk";"Folder";"File";"Size";"Date";"Time";"Description"

so a few lines of the exported file can look like:

"CD 07";"\extras\animate";"and.bmp";"1.12 kB";"26.12.94";"14:13";"Logo"

"CD 07";"\extras\animate";"animate.dpr";"0.16 kB";"23.12.94";"11:24";""

"CD 07";"\extras\animate";"animate.exe";"188.8 kB";"26.6.95";"13:13";""

This format is suitable for easy import to databases or spreadsheets. The disadvantage is that a lot of space is occupied by repeating the disk and folder names on each line, although these items remain constant within many lines.

Leveled - tab delimited.defd

The records are separated by the tab character in this format. Disk names and folder names are on standalone lines. This format might be suitable for tables in spreadsheets or word processors. Tab characters are not visible in this example:

D:\DiskBase\My archive.qdr

  CD 07

    \extras\animate

      File               Size      Date   Time  Description

      and.bmp         1.12 kB  26.12.94  14:13  Logo

      animate.dpr     0.16 kB  23.12.94  11:24

      animate.exe    188.8 kB   26.6.94  13:13

HTML brief.defd, HTML Detailed.defd

These formats create the output in form of HTML page with tables. Note again that the export formats can be modified, so you can customize the HTML output according your needs.

Similar formats are available for exporting the lists of found items (files, disks). 

See also:

Exporting the database

Compressing the database

Creation of read-only database

Importing the database



Writing Your Own Export Formats

This chapter describes how to write your own export format file.

The export format file is a plain text file that can be created or modified by any plain text editor, for example Windows Notepad. 

The export format files are stored in the Export subfolder, that lies in the folder with DiskBase.exe program. The Setup program registers the files with the .defd, deff and .defs extensions (format files - see Exporting database to other formats) to be opened by Notepad, so you can just double-click on any of these files in Windows Explorer to open it.

The first line must always contain the following sentence:

DiskBase Export Format Definition File

Without it DiskBase would not consider the file to be a valid export format file.

Any line beginning with two slashes (//) is ignored, so you can write any comment after two slashes.

First, let's have a look at a simple export format file:

DiskBase Export Format Definition File



IdentifierBegin = <<

IdentifierEnd   = >>

DefaultExt      = txt

FileFilter      = Text files (*.txt)|*.txt



//=================================================================

<<On Database Begin>>

Database: <<DatabasePath>><<DatabaseName>><<CrLf>>

//-----------------------------------------------------------------

<<On Disk Begin>>

  Disk: <<DiskName>><<CrLf>>

//-----------------------------------------------------------------

<<On Folder Begin>>

    Folder: <<PathToFolder>><<FolderName>><<CrLf>>

      File<<Tab>>Size<<Tab>>Date<<Tab>>Time<<Tab>>Description<<CrLf>>

//-----------------------------------------------------------------

<<On File>>

<<FileName>><<Tab>><<FileSize>><<Tab>><<FileDate>><<Tab>><<FileTime>><<Tab>><<ShortDesc>><<CrLf>>



As you can see, the file begins with a section, where various settings are done, and then the rest of the file consists of sections beginning with <<On...>>. 

Export with such format then looks like this (tab characters are not visible):

Database: D:\DiskBase\My archive.qdr

  Disk: CD 07

    Folder: \extras\animate

      File               Size      Date   Time  Description

      and.bmp         1.12 kB  26.12.94  14:13  Logo

      animate.dpr     0.16 kB  23.12.94  11:24

      animate.exe    188.8 kB   26.6.94  13:13



Settings

The settings section has the form of identifier=value pairs. The following settings are available:

IdentifierBegin = <<�IdentifierEnd   = >>

Specifies the characters before and after the identifier in the section below. By default it is << and >>, so an identifier looks like: <<FileSize>>.

Identifier is a word that is replaced by a value when the export is done, for example "<<FileSize>>" is replaced by a file size value, like "1.27 kB" in the exported text. 

MaxDescLines = 10

Maximum number of lines a description will have, when exported. If the description has more than the specified number of lines, the rest of the lines are not exported. Default value = 0, which means no limit.

MaxDescSize = 250

Maximum number of bytes (characters), that will be exported from a description; if the description is larger, the rest characters are cut off in the export. Default value = 0, which means no limit.

FileColumns = 3

In case you need to organize the list of files in the export to several columns (see for example the HTML Brief.defd format), set the number of columns here. During export, DiskBase divides the number of files in the folder by this value and use <<On Each Column Begin>> or <<On Each Column End>> sections when each column is beginning or ending. Default value is 1.

DefaultExt = txt�FileFilter = Text files(*.txt)|*.txt

These two settings influence the dialog box for selecting the output file name. 

DefaultExt is the extension that is added to the file name, if you do not write any extension. 

FileFilter is the list of filters, that will be available in the dialog box in the  "Type of the file" combo box. It should be written in the form "type name|mask|type name|mask|...". Multiple masks can be specified, separated by semicolon, for example:

FileFilter = HTML files (*.htm,*.html)|*.htm;*html



ExcludeChars = ";

Specifies the list of characters, that are to be replaced by the space character. Default value is empty (no characters to be excluded).

ReplaceChars = ;,"'

Specifies a list of characters pairs, that will be replaced, i.e. if the first character of the pair is found, it is replaced by the second one. For example the ;,"' value would cause replacing every semicolon (;) by a colon (,) and every double quotation mark (") by an apostrophe. Default value is empty (no characters will be replaced).

Sections

The following sections are available:

<<On Database Begin>>            - level 1

  <<On Disk Begin>>                      2

    <<On Folder Begin>>                  3

    <<On First Column Begin>>            3

    <<On Each Column Begin>>             3

      <<On File>>                        4

    <<On Each Column End>>               3

    <<On Last Column End>>               3

    <<On Folder End>>                    3

  <<On Disk End>>                        2

<<On Database End>>                      1

In each section a text with identifiers can be specified. The section is exported when the corresponding event occurs. For example <<On Folder Begin>> event occurs when a new folder is entered when going through the database. If you look at the example above, the section can combine text (that will be written without any changes) and identifiers (that will be replaced by actual values). So the section

<<On Folder Begin>>

    Folder: <<PathToFolder>><<FolderName>><<CrLf>>

      File<<Tab>>Size<<Tab>>Date<<Tab>>Time<<Tab>>Description<<CrLf>>

will produce output like this (tab characters are not visible):

    Folder: \extras\animate

      File               Size      Date   Time  Description

Note the <<Tab>> and <<CrLf>> identifiers. <<Tab>> inserts a tab character into the output, <<CrLf>> inserts a line break. Normal line breaks in the format file are ignored (similarly as in HTML format), so if you need to insert a line break, you must do it by the <<CrLf>> identifier.

Each section belongs to a certain level - there are 4 levels defined:

  1. Database�  2. Disks�  3. Folders�  4. Files

Some identifiers are valid in certain levels only. The names of the identifiers are self-explanatory: 

Identifiers that can be used in levels 1, 2, 3, 4:

  <<DatabaseName>>

  <<DatabasePath>>

  <<NumberOfDisks>>

  <<CrLf>>

  <<Tab>>

  <<Space>>

Identifiers that can be used in levels 2, 3, 4:

  <<DiskName>>

  <<DiskSizeKB>>

  <<DiskFreeKB>>

  <<DiskFreePercent>>

  <<Folders>>

  <<Files>>

  <<Archives>>

  <<TotalFilesInArchives>>

  <<TotalFoldersInArchives>>

  <<TotalDataSize>>

  <<OriginalPath>>

  <<VolumeLabel>>

  <<TotalDataSize>>

  <<PhysSize>>

  <<ArchSize>>

  <<ScanDate>>

Identifiers that can be used in levels 3, 4:

  <<PathToFolder>>

  <<FolderName>>

  <<FolderDataSize>>

  <<FilesInFolder>>

  <<FoldersInFolder>>

  <<PhysFolderDataSize>>

  <<PhysFilesInFolder>>

  <<PhysFoldersInFolder>>

Identifiers that can be used in level 4:

  <<FileName>>

  <<FileSize>>

  <<FileDate>>

  <<FileTime>>

  <<ShortDesc>>

  <<Desc>>



The above text applies to the export formats for database. The export formats for lists of found files and lists of free space are more limited:

Export from Found File List (.deff)

The following sections are recognized:

<<On Database Begin>> - level 1

  <<On File>>         - level 2

<<On Database End>>

Identifiers that can be used in levels 1, 2:

<<DatabaseName>>

<<DatabasePath>>

Identifiers that can be used in level 2:

<<DiskName>>

<<FolderName>>

<<FileName>>

<<FileSize>>

<<FileDate>>

<<FileTime>>

<<ShortDesc>>

<<Desc>>

Export from List of Free Space (.defs)

The following sections are recognized:

<<On Database Begin>> - level 1

  <<On Disk Begin>>   - level 2 (no disk end)

<<On Database End>>

Identifiers that can be used in levels 1, 2:

<<DatabaseName>>

<<DatabasePath>>

Identifiers that can be used in level 2:

<<DiskName>>

<<DiskSizeKb>>

<<DiskFreeKb>>

<<DiskFreePercent>>



See also:

Exporting database to other formats

Exporting the database

Compressing the database

Repairing the database

Creation of read-only database

Importing the database



Creation of Read-only Database

This command works similarly as the export with the difference that the exported database is set to be read-only. This feature is enabled in the registered version of the program only. 

The read-only database can be viewed by the unregistered version of DiskBase without any limitation, so the users need not to purchase a license of DiskBase if they want to use it just for viewing a database created by someone else. This can be useful for providing a disk search tool on CD-ROMs.

ATTENTION: There is no reverse conversion of read-only database back to normal database available. So always save the original database, from which you made the read-only one.

See also:

Compressing the database

Repairing the database

Exporting the database

Exporting database to other formats

Importing the database



Importing Database

The meaning of the import word here is reading all disks from a database into the currently opened database. The import can be executed by the "File -> Import..." command. 

If some of the imported disks has the name which already exists in the database, the name of the imported disk is modified by the tilda character (~) and a number in order to make the name unique.

See also:

Compressing the database

Exporting the database

Exporting database to other formats

Creation of read-only database



Command Line Mode

DiskBase can be run with parameters on the command line. This feature can be used namely to force DiskBase to make some action (like scanning a disk) and optionally end itself after finishing the action.

Although the command line seems to be a DOS relic, it is available under Windows too. The most often usage is to create an icon for some action and set the command line by the icon. For example, you can prepare an icon for scanning a disk in drive A:.

In Windows 3.1x you can acquire the icon simply by copying the existing icon of the DiskBase program itself - by pressing the <Ctrl> key, holding it and dragging the icon with mouse to a new position. Then you can set the command line by the "File -> Properties".

In Windows 95,98 and NT4 you can create an icon by creating a Shortcut (by clicking with the right mouse button on the icon of the DiskBase program). Then you select Properties of the shortcut (again by right mouse button) and in the Properties dialog box you set the command line.

Parameters

Let's start with examples first:

The command: 

DISKBASE.EXE d:\qdata\floppies.qdr /s:a /a

means: start DiskBase, scan disk in A: drive and automatically exit the program after successfully doing so.

DISKBASE.EXE is the name of the file with the DiskBase program, the rest are the command line parameters.

The parameters are:

d:\qdata\floppies.qdr 	open database of this name 

/s:a 	scan the A: disk

/a 	exit automatically the program after the action is done (if everything proceeds O.K.).

Similarly the command: 

DISKBASE.EXE d:\qdata\floppies.qdr /f:plan*.zip

means searching for files that matches the "plan*.zip".mask.

As can be seen from the examples the parameters (with the exception of the database name) have the form: slash + letter(s) (+ colon + text). The order of parameters is not significant.

The Database Name

is best to specify with the complete path. When the database name is specified, DiskBase opens it at startup.

The /f: Parameter

is used for file search (find). After the colon the mask must be specified. There should be no spaces around the colon (:). If the searched text contains spaces, it must be surrounded by the "|" characters, otherwise the space will be considered as the end of the parameter.

Example: /f:|"ACME Logo*.cdr" Welcome*.doc| 

The /s: Parameter

is used for scanning a disk. The disk letter must be specified after the colon, without spaces. The colon after the disk letter is not to be written. 

You can also specify multiple disks to be scanned by writing their letters, for example /s:cdef will scan disks C:, D:, E: and F:. To scan multiple disks, the parameter /a must be used, otherwise only the first disk in the list is scanned.

This parameter cannot be combined with the /f parameter.

The /a Parameter

means automatic program exit after the action is done and everything went well. Can be used in conjunction with the /s parameter only. 



Technical Data

The DiskBase program requirements for the hardware is determined mostly by the Windows 3.1x, 95 and NT operating systems. The computer should have an accelerated graphic adapter. The recommended minimal configuration is PC with i486 / 100 MHz or Pentium / 75 MHz, with VGA and IDE connected over a local bus. 

16-bit version: MS-Windows 3.1x + min. 8 MB RAM

32-bit version: MS-Windows 95 + min. 16 MB RAM or MS-Windows NT 4.0 + min. 24 MB RAM.

Program Limitations

There are the following limitations in the 5 version:

Maximum number of disks in one database (including deleted): 	10000

Maximum size of a description: 	32 kB

Maximum number of found items (16-bit version) 	16000

Maximum number of found items (32-bit version)	50000

Program Speed

Scanning a Disk

The speed of scanning is dependent on the following factors:

--	if archives are scanned - the speed then depends on the type of archives,

--	if self-extracting archives are analyzed,

--	if descriptions are read from files - this also means that each file name must be compared with a list of masks and also the filters can have different speed,

--	if descriptions are extracted from ZIP archives,

--	if the disk already exists in the database - in such case each file is looked up in the database first, to verify whether a description is to be copied..

And of course, the main factor is the speed of the media; a hard disk is usually substantially faster than a CD-ROM or a floppy disk.

Search in the Database

Beside the disk and computer speed the search speed is also dependent on:

--	how complex is the search criteria (for example the more masks, the more comparisons the program must make)

--	if you are searching also in descriptions and how they are large.

Measured Speed

The following are the results of measurements made on old PC Pentium/75 MHz, with VGA card PCI ATI Xpression, HD Quantum Fireball 1024 MB, 24 MB RAM:

Scanning a fixed disk contents without scanning archives and descriptions and without the disk already being in the database: 

16-bit version: 370 files/second

32-bit version: 450 files/second

Searching in the database using a simple mask, without search in descriptions:

16-bit version: 2600 files/second

32-bit version: 3100 files/second

Database Size

The database has a header and an index table, together occupying approx. 64 kB. This is also the minimal database size, i.e. the size of an empty database.

The names and texts use one-byte encoding (no Unicode yet).

One file occupies [19 + length of the file name] bytes.

One folder occupies [39 + length of the folder name] bytes.

One description occupies [12 + length of its text] bytes.

The head of one disk occupies 1180 bytes.



What is New in this Version

(The following list is also contained in the Version Info.txt file).



Version 5.12

============



The "Strict mask" option was added to the Search dialog box. 



The "Search as ANSI text" and "Search as OEM text" options were added to "More Options for Search" dialog box. These options enable to search also in automatically created descriptions that were created from files in OEM (DOS) encoding (this option is significant for non English languages only).



When opening a file that lies in the archive, DiskBase now opens the archive, using the associated program.



-------------------------------------------------



Version 5.11

============



The development of the 16-bit version (for Windows 3.1x) and 32-bit version (for Windows 95/98/NT4) was separated. The 16-bit version got the new database engine and some other enhancements (as the 32-bit version did), but most of the other enhancements apply to the 32-bit version only. The next development of the 16-bit version is stopped; only bugs will be removed.

The separation of the code enabled to better utilize Windows 95 user interface features in the 32-bit version; it is partially done in this version; it will be more utilized in the next versions.



*** Export to Other Formats ***



Export to various text formats was implemented as a new feature. Exported files can be used as imports to other applications, like MS-Office. The available formats include semicolon delimited format, tab delimited format, HTML format. Export can be applied to the whole database or to selected parts. Also lists of found files and disks can be fully or partially exported.



The export formats are open - each format is defined by a text definition file. You can modify the existing formats or create new export formats according to your needs. See Help for details.



*** Opening Files ***



Many users requested possibility to open a file when it is double-clicked on it (or Enter key pressed) - similarly as it is possible in the Windows Explorer. This feature is available in DiskBase now. Of course, for successful action the corresponding disk must be present in your computer - if it is not, you get an explanatory message, so you can find the disk in your archive, put it in the PC and repeat the request.



This feature can be switched off in order to avoid unwanted opening of files - when switched off, it is still available when you do the same action while holding the Shift key. Moreover, when holding the Shift key, you can open also a folder - instead of switching to the double-clicked folder in DiskBase, Windows Explorer is used to open the folder.



When you use Ctrl instead of Shift, you will open the file/folder description - this is a new shortcut (besides F2).



*** Database ***



Although this will not be much visible for most users, the internal database engine was significantly rebuild. The engine can now recover from errors caused by corrupted data in the database. In previous version such errors caused immediate close of the database and inability to use the database.



A new command "Repair Database" was added to the "File" menu. This command can repair partially corrupted database - it is doing so by removing all the corrupted data from the database, so you should still keep on mind that instead of repairing corrupted database it is much better to backup it regularly. 



In the previous version the database grown with each update of the disk in database nearly as much as with adding a new disk to the database. Now the database engine is able to reuse unchanged records, so when rescanning a disk, only folders with changes are recorded. Thus the database grows much less and thus it is less needed to compress it.



An option "Open last opened database at startup" was added. DiskBase now also remembers the last used folder (in the opening dialog box).



In the "File" menu you can now find the list of recently used databases, as it is usual in other programs.



New feature: If the database lies on a read-only medium, or has the Read-Only attribute set, all the editing functions are disabled and DiskBase does not try to write to it, so no error messages are displayed. In other words: the database can be now put on read-only media, even if it is not exported to the Read-Only format.



The DiskBase Database type (the .QDR extension) is now registered by the Setup program in Windows, so you can open the database simply by double-clicking on it in Windows Explorer, as it is usual by other applications.



*** Scanning Disks ***



A "Template for disk name generation" is now available, enabling to create volume labels more comfortably. This can be utilized when you want to assign names like "Snaps from summer 99, disk 1 from 9". 



Multiple disks can be selected to be scanned. A "No queries" option was added, which enables to forbid any questions, so you can run a time consuming scan of multiple large disks without supervising it. 



Multiple disks to be scanned can be also specified in the command line.



The sizes of disks with capacity larger than 2 GB were incorrectly reported. This problem was removed from DiskBase in case DiskBase is running under Windows 95 OSR2, Windows 98 or Windows NT4. It could not be removed under Windows 95 (first version), because there the operating system itself does not provide correct information.



ZIP files with zero length caused program crash when descriptions were extracted from them. Similar problem was caused by some self-extracting EXE files of ZIP type. Corrected.



Accented characters in file names in ZIP archives were incorrectly displayed. Corrected.



*** Filters ***



New filter is available for files of MPEG3 type. The filter reads the TAG (title, artist, album, genre, comment) and some technical parameters (bitrate, sampling frequency, etc.). 



When a new database is created, common filters are automatically put into the list of rules - for files TXT, HTML, DOC, RTF, MP3 - so it is not necessary to create the list for every new database you create.



The UNI filter was enhanced, so it can now read also an Unicode text (English only). That means the UNI filter can be used for example for documents created in Word 97, which already uses Unicode. A new option "Always recreate descriptions from files" was added - this options enable to correct descriptions already created with the previous version of the filter.



*** Searching ***



Now it is possible to search in specified folders, for example you can search only in the "\Letters" folder on all disks where such folder exists, and optionally its subfolders. 



Another option is possibility to search in subfolders till specified level.



Possibility to distinguish searching in files only, folders only and text only was added.



As the wildcard convention for searching makes problems to users, who do not like to read Help, two options were added to the Search window: "Search also as parts of words" and "Search as phrase" - the asterisks and quotation marks are then added automatically to the searched text.



Originally the method for searching (i.e. matching the mask) in file and folder names was partially different from the method used for searching in descriptions. The differences are now described in the Help as Strict Mask Type (originally used for file/folder names) and Relaxed Mask Type (for descriptions). The Strict type is not much suitable for searching in long file names, so in this version the mask for searching in file and folder names is also considered to be of the Relaxed type. See the detailed description in Help. 



DiskBase now remembers history of your requests to search to the next session, which makes the program usage more comfortable.



*** Clipboard ***



Transfer via Clipboard was limited to 32 kB in previous versions, i.e. number of records (lines) that could be put to Clipboard was limited. The limit was removed in this version.



*** Y2K ***



DiskBase was not 100% Year 2000 compliant - a small bug was in the display of the year 2000 which was displayed as 100 instead of 00. This bug was only in the display format; internally the date is stored in binary form in DiskBase, so DiskBase does not have any other Y2K problem. Corrected.



*** Printing ***



In some cases the width of the printed columns with file names was not corresponding to the real width of file names (when printing the database contents). This was corrected by adding the "Adjust name column width" option to the program Settings. See Help for details.



Even when printing one page only, still a warning about printing multiple pages was displayed. Corrected.



*** Other ***



A button "Paste Last" was added to the window for editing the description. This button inserts a copy of the last edited description, so it is easier to create multiple descriptions of similar contents (however, as it is explained in Help, it is still recommended to prefer automatic description creation).



The Ctrl-A key shortcut was changed to "Select All" function (originally it was Scan A:"), which is a common shortcut in many programs. The Ctrl-B ("Scan B:") shortcut was removed.



The list of available disks in the system sometimes displayed also non-existing disks. Corrected.



A bug caused that after renaming a disk (i.e. physically changing the volume label) DiskBase sometimes still worked with the old name. Corrected.



The option "Use Windows language support for sorting" was removed. The problem of sorting in some language versions of Windows was solved internally, by resorting the keys in the database every time it is opened, so the database is also transportable between various language versions of Windows.



The dialog box for sorting the list of disk sizes was not functional and moreover, it was impractical, so it was removed. The sort order can be changed easily by clicking on a column header.



By clicking on the same column header again, the sort order is reversed (new feature).



A bug caused that the command line option /S:O could not be used without /A option. Corrected.



In the 16-bit version an error occurred when the list of found items had more than 16000 lines. Corrected.



When the button "Cancel" was pressed during rescanning the disk, the original disk was marked as deleted in the database. Corrected.



Added was an option "Do not offer volume name change" - checking this option suppresses displaying the volume label change dialog box, so you can avoid accidental change of it.



Some dialog boxes did not respond to the <Esc> key properly. Corrected.



When the tree panel width was set to 0, it was not possible to restore it in any other way, than by editing the INI file. Corrected.



When setting the "Open database at startup" field, it was not possible to specify the name of currently opened database. Corrected.



-------------------------------------------------



Version 5.10

============



Extracting of descriptions from ZIP archives was added to DiskBase. This function is disabled as default. To enable it, check the "Extract descriptions from ZIP archives" option in the Settings -> Database Settings -> Options.

If you already have a ZIP archive previously scanned, you must check also the "Always rescan archives" in order to refresh the archive contents

in the database. See Help for details. 



Pop-up bubbles with detailed file information were added to panel with files and to the window with found files.



The internal file system was improved in order to increase stability.



A bug causing that sometimes the content of ZIP files was not fully read into the database was removed.



A bug causing failure of scanning a disk on a file with ZIP extension and size of several bytes was removed.



The 16000 items limit was removed in the 32-bit version; as the result now the list of found files can have more than 16000 items and archive files with more than 16000 files inside can be stored inside the database.



-------------------------------------------------



Version 5.09a

=============



A bug causing that the values for archives (number of files, folders and total data size) in the "Disk information" dialog box were not displayed correctly after rescanning the disk. To get right values, compress the database - the values are recalculated during compression.



There was an incorrect explanation of the values displayed in the status line (subtotals for current folder) in DiskBase Help - corrected.



-------------------------------------------------



Version 5.09

============



The information about the current folder displayed in the status line was available only for newly rescanned disks in the previous version of the program. Now it is enough to compress the database and the needed information is recalculated, so it is displayed for all the disks then - there is no more need to rescan the disks just because of this matter.



-------------------------------------------------



Version 5.08

============



DiskBase can now scan self-extracting archives (exe files) of ZIP, ARJ and RAR types (extraction of descriptions from archives is not supported yet, but it is planned for the ZIP archives).



A folder can be now scanned and saved to the database as a standalone disk.



A "rescan disk" command was added - this command is useful namely when the disk that is to be rescanned has a different name than is its volume label.



The internal database structure was changed. You may not notice this fact until you try to use earlier DiskBase versions to open a database that was created or opened by this version.



The window with database now displays in lower left part (status line) information about the number of folders, files and data size contained in current folder. However, this information is correct for the newly scanned disks only.



A bug causing that the read-only database could not be freely opened by the unregistered version of DiskBase was removed.



-------------------------------------------------



Version 5.07

============



Printing: DiskBase did not sort files in folders when the whole disks were printed. In this version the sorting for this case was added to the program; files are sorted according to the criteria set in the Program Settings dialog box.



You can now switch off the scanning of volume names for the "Scan disk" dialog box (scanning of volume names can take pretty long time when using CD-ROM changer, for example). See Help for detailed explanation.



The Scan Disk dialog box was redesigned; now it is sizable, so if the names of the disks are too long, you can easily enlarge it.



In some rare cases the Windows language driver may not function properly. You can now switch off using the Windows language driver by DiskBase. See Help for detailed explanation.



-------------------------------------------------



Version 5.06

============



A bug causing a loose of a disk description after two rescans was removed.



-------------------------------------------------



Version 5.05

============



Descriptions of disks are now available.



Maximum size of description is now set in bytes (instead of kB) and the minimum value is now 100 bytes (originally it was 1 kB which was too much).



In the Program Settings you can now select arithmetic used for calculation of kB and MB from bytes; 1 kB can be either 1024 bytes or 1000 bytes.



In the 32-bit version the language script for fonts could not be set - only the default one was used. This problem was corrected, so the proper language script can be used.



The [Home] and [End] key functions in the file display were corrected.



Problem with saving an empty description was corrected.



In the previous version a disk could not be renamed if the change was in the character case only (for example from "my disk c:" to "My disk C:"). This problem was corrected.



In some language versions of Windows (Hungarian for example) the date was not properly displayed. This problem was corrected and a possibility to use the Windows system Short Date format was added to Program Settings.



In the 32-bit version the folders with the Hidden attribute set were not put to the database (for example the folder with cache files of Internet Explorer). Corrected.



Default folder for opening the database files is now taken from the "Open database at startup" specification (if set).



-------------------------------------------------



Version 5.04

============



The widths of panels in the database window can be saved to the configuration file, so they are preserved when you run DiskBase next time. Small changes in the Search dialog box were also done.



-------------------------------------------------



Version 5.03

============



The registration process was greatly simplified. See DiskBase help for details.



-------------------------------------------------



Version 5.02

============



This is the first English version of DiskBase.



You could not hear about earlier versions as till version 4 the program was available in Czech language only. The history of the program began in 1991, when it was formed as a collection of command-line utilities rather than standalone program. The first commercially successful version was version 4, released in 1994. The version 5 is the first version for Windows and was released in 1996 in Czech language and translated to English version in 1997.



The program in the Czech version is called QuickDir from the very beginning. However, before doing the translation to English language we found that a shareware of the same name already existed (a DOS file manager), so we decided to use the DiskBase name for the international versions in order to avoid misunderstandings.



See also:

FAQ - frequently asked question

Known problems



FAQ - Frequently Asked Questions

If I buy a DiskBase multilicense, does it mean that multiple users then can access one database simultaneously?

No. The multiple license just saves money (in comparison with buying each license separately). DiskBase enables to open the database to 1 user only. So, if the database is placed on a network drive, it can be accessed by multiple users, but not simultaneously.

When extracting descriptions from files in ZIP archives, are the same rules (filters) used in the same way as for normal files?

Yes. The rules specified in Settings->Database settings->Descriptions are used for extraction of descriptions from ZIP archives too.

Is it possible to catalog a network disk i.e. on another computer of a network?

Yes. If this disk behaves as a normal disk (e.g. you can see it as a disk in Windows Explorer), then it is possible to scan it to DiskBase database. Note that files on network disks can have various access limitations - for example you can see a name of a file, but you cannot read it - in such case DiskBase would not be able to create a description from such file or look inside (if it is an archive). As there can be thousands of such files, DiskBase never announces this to you, it simply skips reading of such files. 

When I catalog CD-ROMs, they either started to install or run when the drive door is closed.

This is a feature of Windows 95 and Windows NT4 - after inserting the CD-ROM in the drive, the operating system looks for a file called AUTORUN.INF on the CD-ROM, where are the commands to be executed. You can disable the AutoRun feature in two ways: �- by pressing and holding the Shift key for a while after you insert a CD-ROM in the drive, �- or by permanently switching this feature off in Windows 95. You can do so in the Start Menu -> Control Panel -> System -> Device Manager -> select the CD-ROM device and Properties and uncheck the AutoRun check box.

I reorganized files on my hard disk (moved some folders) and then, after rescanning the disk I found that some descriptions were lost in the database.

As it is mentioned in DiskBase Help, this is the disadvantage of the manually edited descriptions: if the file, to which the description belongs, is moved somewhere else, DiskBase considers it as a deleted file and thus does not preserve its description (detecting possible file movements would be very complicated task). So it is recommended to keep on mind the following rule: Whenever possible, prefer automatically created descriptions. In other words, use manually edited descriptions only on disks, contents of which will not change (CD-ROMs, installation floppies). On all other disks (hard disks, backup disks etc.,) place the files with descriptions (named e.g. DirInfo.txt) directly to the disks and let DiskBase read these files as descriptions. Then, when you reorganize folders and move or copy even from one disk to another, the descriptions are still preserved.

I wanted to set a long name as a volume label on a floppy disk, but it was refused by DiskBase. 

Although Microsoft extended the FAT file system for long file names usage, this unfortunately does not apply to volume labels, which are still restricted to 12 characters.

I wanted to find all files and folders matching the mask ORDER*.*, but it did not find the folder ORDERS, although the folder exists in the database.

With the long names introduced in Windows 95, the dot (.) character is no more a special character, but just one of the permitted characters. In the old DOS the dot was added to each name to separate the name and the extension and the mask "ORDER*.*" would be considered as: Find files, which names begin with "order" and the extension is arbitrary. But in long names there can be multiple dots in one name. So the same mask in DiskBase is interpreted as: Find files, in which some word begins with "order", then there can be some arbitrary characters, then there must be a dot and finally there can be some other arbitrary characters. DiskBase uses this way of interpretation of the mask. The folder name "ORDERS" does not have any dots in its name, so it is not found. You should use the "ORDER*" mask instead of "ORDER*.*".

I wanted to find the file My Document.doc, but DiskBase did not find it, although the file is in the database.

This problem was caused by using the Strict mask type for searching in file names. From version 5.11 the mask is considered as Relaxed type, which removes this problem. See detailed description in the Help.

How can I export the search results to MS-Excel?

Such export was not available till version 5.10, but is available from version 5.11 as Export to other format. For Excel the Tab delimited.deff format should be suitable.

You can also copy selected lines to Clipboard (Edit -> Copy) and paste them from Clipboard to Excel (Edit -> Paste). This transfer was limited to 32kB of text till the version 5.10, from version 5.11 (32-bit) it is not limited.

My G: drive is my CD-ROM drive. The buttons on your tool bar say A B C. How can I scan G:? 

By pressing the "C..." button (the ellipsis indicates "C and other disks"). You will get selection of all disks available in your system.

How can I delete a description?

By opening it and deleting all the text inside.

I have changed a description on disk, but after rescanning the disk the corresponding description in the database was not updated.

This happens (intentionally) when the description is manually modified in the database; then it is protected against being rewritten automatically. The solution is to delete the description, i.e. open it, delete its whole contents (with all lines and spaces). Then rescan the disk.

Is the registration dependent on my computer, i.e. will the registered program function, if I upgrade my computer?

The registration is not dependent on the computer and the program can be copied to another computer.

I have registered version of DiskBase and want to install an update. How can I register the update?

You need not register the update. If you install the update to the same folder, where the previous version was placed, the registration is preserved. If you install the update to a different folder, then you must copy the DiskBase.lic file from the previous version to the folder with the new version. DiskBase check existence of this file at its startup. 



See also:

What is new in this version

Known problems

What to do in case of other troubles with the program



Known Problems

Program Cannot be Run

When I try to run the program, I get the following error: There is no default printer currently selected...

Solution: This error happens only in case you have no printer installed in Windows or no default printer is selected. To remove the problem, install any common printer driver into Windows (you can do that even if there is no printer connected to your computer) or set one of existing installed printer drivers as the default one.

See also:

FAQ - frequently asked question

What to do in case of other troubles with the program



What to Do in Case of Troubles With the Program

A special care was taken about the database immunity against errors caused by undiscovered bugs in the program (however, making a backup of database regularly should not be underestimated).

If you discover a bug in the program, first try to download the latest version of the program and verify if the bug is still there. It may be that somebody already discovered this bug, notified us about it and we corrected it. Also check if the bug is not described in the list of Known problems (that cannot be removed).

If you do not find it there, then please try to describe as exactly as possible the steps leading to the problem occurrence, best from the program startup. Specify also the environment (hardware, operating system, concurrently running software). Then send the description to our address; see Contact Info for our address.

If the bug is connected with one specific file or database, it may help us significantly if you send us the file or database (of course if you do not have secret data there).

We will try to fix the bug as quickly as possible and publish the updated version of the program on our Web pages, from which you can then download it.

Note that some bugs may be connected with specific environment conditions (or even caused by the environment) and we also might not be able to repeat the problem on another computer; so we cannot guarantee that we will be able to repair every bug, but we will try to do the best to do so.

See also:

FAQ - frequently asked question

Known problems



List of Recognized Types of Archive Files

DiskBase is able to recognize the following types of archives:

The ZIP Format

ZIP is one of the most popular formats and is created by a number of programs. Unfortunately not all of them are using exactly the same data format, which can potentially cause problems.

ZIP files usually have a central directory of stored files at the end of file, which enables fast reading of the archive contents. If it is not so, the whole file must be read sequentially, which is slower.

Programs creating the ZIP format are namely:

--	PKZIP by PkWare, can be found at http://www.pkware.com

--	WINZIP, can be found at http://www.winzip.com

Tested with versions: 	PKZIP for DOS 1.02, 1.1, 2.04g, PKZIP for Windows 2.50, WINZIP 6.2, Norton Commander 4.0.

The ARJ Format

Format used by ARJ, another popular archiver program. The author of the program is Robert A. Jung and the program can be downloaded from http://www.websoftware.com/arj.htm

There is no central directory in this file format, so the file must be read sequentially. DiskBase supports also reading the contents of archives split by ARJ to several files (with the .A01, .A02,... extension).

Tested with versions:	ARJ 2.0, 2.41, 2.50, 2.55

The RAR Format

is created by RAR, an archiver program which became popular in recent years. The author of the program is Eugen Roshal and the program can be downloaded from http://www.ivsoft.com/ivcs/RAR.HTM

There is no central directory in this file format, so the file must be read sequentially.

Tested with versions: 	RAR 2.0, WINRAR 2.0

The LZH Format

is created by LHARC and LHA programs, author of which is Haruyasu Yoshizaki.

There is no central directory in this file format, so the file must be read sequentially.

Tested with versions: 	LHARC 1.13c, LHA 2.10.

The ARC Format

is created by an older archiver program PKARC (by PKWare).

There is no central directory in this file format, so the file must be read sequentially.

Tested with versions: 	PKARC 3.6, PKPAK 3.61.



Creation of Conversion Filters

This chapter is intended for programmers, who want to create their own conversion filters. Visit also our web site (Contact Info) - downloadable sample filter is available there.

The conversion filter is a DLL with a simple interface. Instead of the ".DLL" extension, the ".Q16" (for 16-bit version) and ".Q32" (for 32-bit version) are used. The reason for it is automatic recognition of available filters by DiskBase at startup: if you create a new filter, it is enough just to place it in the folder with the program and DiskBase will show it in the list of available filters (after restarting the program). 

You cannot mix 16-bit DLL and 32-bit version of DiskBase and vice versa; 16-bit DLLs must be created for 16-bit version of the program, 32-bit DLLs must be created for 32-bit version of the program.

The DLL interface consists of three functions.

In C++ their declaration looks like this:

long OpenTransfer (char* pszFileName, long& Handle);

long GetOneBlock  (long Handle, char* Buf, long BufSize, long& CharsRead);

long CloseTransfer(long Handle);

In Pascal it would look like this:

function OpenTransfer (FileName: PChar; var Handle: longint): longint;

function GetOneBlock  (Handle: longint; Buf: PChar; BufSize: longint; var CharsRead: longint): longint;

function CloseTransfer(Handle: longint): longint;

The OpenTransfer function is used to open the file. FileName is a zero terminated string with the name of the file (full path is required). The function must return a handle to the open file in the Handle parameter and itself must return 0 in case the opening of the file was successful. The handle is then used when calling the other two functions to identify the file. The DLL should be able to open multiple files at one time and should be reentrant. Although such features are not used in the current version, multithreading can be introduced to file scanning in the future 32-bit versions of DiskBase.

The CloseTransfer function closes the file. If closing was successful, the function must return 0 value. 

The GetOneBlock function is used to read the text. Its task is to insert into the Buf array converted text of maximum length equal to BufSize. The function must return the actual length of the text in the CharsRead parameter; this length can be shorter than BufSize. The GetOneBlock function is called repeatedly, until the requested size of the text is transferred. When the function returns zero length in the CharsRead parameter, it is considered as the end of the file and the reading is closed. The function itself must return 0 if everything is processed O.K., and non zero value, when an error is encountered. The Buf array is never larger than 64 kB.

Notes:

--	The functions must be exported with the Pascal calling convention in 16-bit version and Register calling convention in 32-bit version..

--	If the compiler used for DLL creation supports using exceptions, all the exceptions must be catched inside the DLL, i.e. there must not be uncatched exception left in the stack.

--	DiskBase does not display any error message when the file cannot be read; it simply skips it. The same behavior is expected from the DLL: no dialog boxes should stop the program.

--	When using C++, remember to export functions as extern "C" { ... }, so mangling of names is avoided.

--	Be careful to open the file in the right sharing mode in order to avoid sharing conflicts with other programs.

--	A line break must be represented by CR-LF i.e. 0xD-0xA (13-10).



Registration



Fill in the DiskBase Registration Form after you receive the license number from us.



DiskBase 5 is distributed as shareware (see the What is Shareware? chapter for detailed explanation of the shareware concept), i.e. you got an unregistered version free of charge (if you paid someone for it, you paid just for copying it or for media, but not for the program itself). The unregistered version is fully functional, but it is legal to use it for a one-month evaluation period only, see the Trial Use License chapter. 

If you find the program useful, you should register yourself as a user, so you can use the program legally after the evaluation period. The registration is paid: the price for one license is $29 and there are significant discounts for multiple licenses  (see the Price List chapter for details).

After you make payment for the license to use the program, you will receive the license number and information how to fill in the DiskBase Registration Form. Filling in the form will convert the unregistered version into the registered version, without necessity to reinstall anything.

It is recommended to use a registration service for payment. See information about the registration service below.

Please, Try the Program First

Before registering yourself, try to work with DiskBase for some time. When you are registering the program, we suppose that you are already familiar with it and you know, what you can expect from it and what not. Thus, we do not provide any money-back guarantee. However, we would like to avoid any conflicts with unsatisfied customers.

You should also know the following before you register: 

Where to get the latest version of the program?

What is the difference between the registered and unregistered version?

What I get when I register?

The license is valid also for future versions

Technical Support

Making Payment

There are several possibilities how to pay: 

--	Using a registration service. Using the registration service is highly recommended namely in case you want to purchase one license only and if you want to make the registration process as fast as possible. See Payment using a registration service for details.

--	Sending a check or cash directly to us. The check can be used for multiple licenses only. See Payment by sending a check or cash for details.

--	Making a SWIFT or wire money transfer to our account. This is the most expensive way how to make the payment. See Payment by SWIFT or wire money transfer for details.

Important: In any case we need your name (or company name), postal address and if applicable also your e-mail address or fax number. Be sure you specify it correctly; this applies namely for your e-mail address. If you make a typing error in your e-mail address, you will not receive your registration and we may not be notified about that.

Registration Form

After we receive your payment or confirmation about if from the registration service, we will send you the license number and instructions how to fill in the Registration Form in DiskBase. If you have an e-mail address, we will send it to you by e-mail, if not then we will send it by fax. If you do not have either e-mail or fax, we will send it by snail mail, which can take pretty long time to deliver.

Normally you receive this within 48-hours, only exceptionally this period can be up to 1 week long. Sometimes it happens that the e-mail about your payment is not delivered to us - internet mail is not 100% reliable - so if you do not receive your registration, do not hesitate to contact us.

To open the Registration Form select "Help -> Registration..." command from the menu. 

The registered version shows your name and address in the "About" dialog box. If you order multiple licenses, you still receive a single license number, but the number of licenses is then shown in the "About" dialog box. You should know where is the registration stored in order to make a backup of it and use it for DiskBase updates.

Note: Together with the license number you will receive also an information, how to fill in the other fields in the Registration Form. You must fill it exactly as you receive it. The license number is calculated as a checksum of other fields, so any difference would cause the license number not be valid. To avoid problems with non-English alphabets, only English letters can be used in the Registration Form (no accents, diacritics, umlauts etc.). If you find a typing error in your data you receive from us, please contact us; we will correct it and send it to you with a recalculated license number.

Using Clipboard: If you receive the license number from us by e-mail, select the whole e-mail text and copy it to Clipboard. Then you can paste your data to DiskBase Registration Form by clicking on the "Paste from Clipboard" button, instead of filling it manually.

Acknowledgment

By registering yourself you acknowledge that you have read the Software License Agreement and Limited Warranty, understand it, and agree to be bound by its terms and conditions.



See also: Contact Info.



Where to Get the Latest Version of the Program?

We have a WWW site on Internet which is the only genuine home page for DiskBase, see Contact Info for the WWW address. You can easily download the latest version of the program from there. We recommend to do so if you want to be sure that the program was not modified by someone putting a virus inside. 



What Is the Difference between the Registered and Unregistered Version?

There are two differences only:

--	The unregistered version displays a dialog box, reminding that you are working with an unregistered version. This dialog box is displayed once at the program startup. If you open some database that is older than one month (= evaluation period), the dialog box appears also from time to time during the program execution. You must confirm the dialog box in order to continue working with the program. The registered version does not display this dialog box, of course. When the unregistered program ends, the Help window with topic about registration pops-us.

--	There is a possibility to create read-only versions of databases with DiskBase. The read-only database cannot be modified; the user can just explore its content. When you open the read-only database with an unregistered version of DiskBase, the reminder dialog box is not displayed and the DiskBase Trial Use License enables to use DiskBase with read-only databases free of charge (see the Trial Use License chapter). This feature enables you to distribute databases created by DiskBase without necessity to force the users to buy DiskBase. The read-only database can be created by the registered version of DiskBase only - this feature can be considered as a bonus for registered users.

There are no other differences between the registered and unregistered version of the program; in fact the registration itself is a just pure software procedure and there is no need to reinstall DiskBase in order to have a registered version.



What I Get When I Register?

You will get the license number . This license number converts your unregistered version into the registered one.

You will NOT get any printed manual - the program is so simple to use that printing a manual would be just a waste of paper. This help file contains all the information about the program.

You will NOT get any floppy disk. The program in its latest version can always be easily downloaded from our WWW site - see Contact Info.



The License Is Valid also for Future Versions

When you receive the license number, it is valid not only for the current version of DiskBase, but also for:

--	all program updates, i.e. all subversions (with any number after the decimal point). �Example: The license for the version 5.11 is valid for all subversions till 5.99.

--	all new versions, that are released within one year period from the registration. �Example: You register version 5.4 in January and the same year in December the version 6.0 is released. As the one-year period is not over in December, you can still use the license for this new version of the program.



Where Is the Registration Stored?

The registered version of the program is able to display who is the owner of the license to use the program in the "About" dialog box. You, as the future owner of the license, enter this information about you in the Registration Form. However, this information is not displayed in the program until it is validated by a license number you receive from us. When it is validated, the program converts itself from unregistered to registered version (and stops displaying the dialog box notifying about the unregistered version).

Physically the registration data are stored in the DiskBase.LIC file, which is placed in the same folder as is the DiskBase.EXE file of the program. DiskBase reads this file at startup and if valid license is found in it, it starts as a registered version. So this file is a key file for your registration; if it is accidentally deleted or corrupted, your license is lost. After registering yourself DiskBase will recommend you to make a backup copy of this file and you really should not ignore this recommendation.

Having the registration stored in a separate file rather than in the program itself has an advantage: You can download a new version of DiskBase and if you put this DiskBase.LIC file to the folder with this new version, the program is then started as registered one. In reality, you will usually do this vice versa - leave the registration file in a folder to which you install the new version of DiskBase, overwriting the previous one.



Payment Using a Registration Service

is usually the easiest and safest way how to make payment. The software registration service is an independent company, that provides easy and fast payment methods; it usually accepts a wide range of kinds of payments, including credit cards, checks, bank money transfers etc., with advantages like secure HTTP protocol (when you send information about your credit card) or 0800-phones.

The registration process might be very fast, if you have an e-mail address and use the registration service for payment: As soon as we receive the notification from the registration service that you paid for the license (by a credit card, for example), we send the license number to you by e-mail. The whole process can take from just a few hours to no more than 48 hours, no matter on which place on the Earth you are.

Important notes: 

--	The registration service is a company focused on selling licenses; do not contact it when you want to get anything else than to order a program license; if you ask for any information about this program or for technical support, you will get just this Contact Info.

--	If you do not receive the license in time or the license number is not working, do not contact the registration service, but contact directly us; the registration service will not help you with this problem.

You can select from two registration services: PsL/DigiBuy (USA) and ShareIt (Europe, USA). It does not matter from which country you are ordering - if you have an e-mail and can pay by a credit card, you can order from anywhere. Be always sure you do not put a typing error in your e-mail address - otherwise we will not be able to deliver you the license number!

You will find links to both registration services on our server: 



http://www.diskbase.com/ordering.htm





ShareIt! - Element 5 AG

Web: http://www.shareit.com

- the web pages are available in English, Spanish, German and Portugal/Brazil languages.

European office:

ShareIt! - element 5 AG�Sachsenring 69�D-50677 Köln/Cologne�Germany 

Telephone: +49 - 221-240 72 79�Fax:-+49 - 221-240 72 78



US office:

ShareIt! Inc. �P.O. Box 844�Greensburg PA 15601-0844�U.S.A. 

Telephone: +1 - 724-850 8186�Fax: +1 - 724-850 8187



DiskBase number in ShareIt! is 100513. 





PsL/DigiBuy Shareware Services

Web: http://www.pslweb.com

Public Software Library�P.O.Box 35705 �Houston, TX 77235-5705�U.S.A.

Telephone:	+1 - 713-610-1432 between 8:30 am and 5:00 pm (CST) Monday through Friday.�Fax:	+1 - 713-523-9803



DiskBase number in PsL/DigiBuy is 93397543943. 



Payment by Sending a Cash

Sending a Cash

You can also send a cash in some easily exchangeable currency - it is less work either for you and for us; however, keep on mind, that it is your own risk to send cash by postal mail. Even if you use a registered mail for this purpose, there is no guarantee, that we will not receive an empty envelope. Our experience is that sending a cash by mail works well, but one never knows...

If you send a cash, you can lower the license fee down to $25 (or equivalent in another currency) in order to reduce the number of banknotes. See our address in Contact Info.

Sending a Check

This way of payment is no longer accepted for paying a single license - the expenses connected with clearing the check are usually too high, so use check only for paying multiple licenses. 

Paying by check is time consuming procedure: it takes some time to the snail mail to deliver the check to us, then it may take some time to verify your check, so the total time to get your license can be counted in weeks rather than in days. However, if you cannot use a registration service for some reason, sending a check is pretty safe and universal way of payment. 

As the recipient the author of DiskBase must be filled in: the author's name is Zdenek Martinek and his address is in Contact Info.





Payment by SWIFT or Wire Money Transfer

is very safe, but usually very expensive way, how to transfer money. All the expenses connected with it must be paid by you (it can be even more than $20); otherwise we will send you a notification how much money is missing from your payment and expect another payment from you.

Due to this high cost we expect that this kind of payment will not be used for single licenses. In case you are going to order a multilicense, site license or unlimited license and pay by money transfer, please contact us first, we will send you an invoice with our account number.

See our address in Contact Info.



What Is Shareware?

Shareware is a marketing technique that allows computer users to try a software program before buying it.  This allows you, the user, a chance to make sure a program runs well on your computer and meets your specific needs ... before paying for it.

Just as retail software has its distribution points, usually in computer stores, shareware has its distribution points as well. You can obtain shareware programs from the Internet, various CD-ROMs, BBS's, disk vendors, AOL, CompuServe, Genie, Prodigy, and a wide variety of other sources, making shareware easily accessible to everyone.

Please understand that the people who write shareware programs work very hard. If you try a shareware program and continue using it, you are expected to purchase it. You'll find the details for buying the program in the documentation that comes with the program. By purchasing the program, you help the program author continue to improve his or her program, and you reward that individual for a job well done.

Remember that copyright laws apply to shareware software just as they do to retail software. You may not copy the shareware program except as allowed in the program's license.



Trial Use License

DiskBase is not freeware and it is not in the public domain. It is sold through the shareware market. As such, you may evaluate the program for a period of one month free of charge. If after that time you decide to continue using DiskBase, you must purchase it (i.e. register it).

The only exception is using the unregistered version of DiskBase for viewing the contents of read-only DiskBase databases, created by a third party. Such use is legal without any time limitation and any requirement to purchase it.

DiskBase and its accompanying documentation are protected by the Copyright law and also by international treaty provisions. Unauthorized reproduction or distribution of this package, or any portion of it, may result in severe civil and criminal penalties.

You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer, or transfer the licensed program except as provided in this agreement.  Any such unauthorized use shall result in immediate and automatic termination of this license.  All rights not expressly granted here are reserved to Zdenek Martinek, the author of the program.



Software License Agreement

This legal document is an agreement between you, the Licensee, and Zdenek Martinek, the Licensor. The subject of the agreement is the Licensor's software program named DiskBase, herein called the Software.

By registering, you agree to be bound by the terms of this agreement. In order to protect the Licensor's rights, the Licensor does not sell any rights to the Software. Rather the Licensor grants the Right to Use the software by means of a software license, which is the subject of purchase by the Licensee.

1. Grant of a License

In consideration of payment of the license fee (part of the price you paid for your registration), and your agreement to abide by the terms and conditions of this License and the Limited Warranty, the Licensor grants you, the Licensee, a non-exclusive right to use this copy of the Software on the number of computers (i.e. CPU's) specified in the registration so long as you comply with the  terms of this License.

2. Ownership of Software

As the Licensee, you own the physical media on which the Software is originally or subsequently recorded, but an express condition of this License is that the Licensor retains title and ownership of the Software recorded on the original disk(s) and all subsequent copies of the Software, regardless of the form or media in or on which the original and other copies may exist. This License is not a sale of the original Software or any copy.

3. Copying Restrictions

The Software and the accompanying written materials are the subject of copyright. Unauthorized copying of the software, including the Software that has been modified, or of the written materials is expressly forbidden. You may be held legally responsible for any copyright infringement which has been encouraged or caused by the failure to abide by the terms of this License. 

See the Distribution Licence for conditions for authorized copying of the Software.

4. Use Restrictions

As the Licensee, you may physically transfer the Software from one computer to another provided that the Software is used on only the number of computers specified in the heading of this License at any one time.

5. Other Limitations

Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or disassemble the Software, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.

Separation of Components. The Software is licensed as a single product. Its component parts may not be separated for use on more than one computer.

Rental or Lease. You may not rent or lease the Software.

Software Transfer. You may not transfer your rights under this Licence to another person or subject.

6. Termination

Without prejudice to any other rights, the Licensor may terminate this License if you fail to comply with the terms and conditions of this License. In such event, you must destroy all copies of the the Software and all of its component parts.



Limited Warranty

This software is provided on an "as is" basis. The author of the software disclaims all warranties relating to this software, whether express or implied, including but not limited to any implied warranties of merchantability or fitness for a particular purpose. Neither the author nor anyone else who has been involved in the creation, production, or delivery of this software shall be liable for any indirect, consequential, or incidental damages arising out of the use or inability to use such software, even if the author has been advised of the possibility of such damages or claims. The person using the software bears all risk as to the quality and performance of the software.



Distribution License

The distribution requirements are the following:

--	Only unregistered version of DiskBase (herein called the Software) can be distributed. It is expressly forbidden to distribute any registered or cracked version of the Software.

--	Only complete and unmodified package of the Software can be distributed. Neither the distributor nor anybody else is permitted to make any extraction, modification and repacking of the package contents, created by the author of DiskBase. The only permitted modification is adding a short zip comment about the distributor to the zip file.

--	If the user pays for the Software, he/she must be clearly informed, that the payment is just for distribution, not for any right to use the Software.

Any distribution satisfying all the distribution requirements expressed above is hereby authorized. No explicit permission from the author needs to be acquired in order to make authorized distribution of the Software.

However, any other copying or distribution is unauthorized and as such is expressly forbidden. You may be held legally responsible for any copyright infringement which has been encouraged or caused by the failure to abide by the terms of this License. 

All rights not expressly granted here are reserved to Zdenek Martinek, the author of the Software.



Technical Support

For the period of 3 months a free technical support is provided, beginning with the date of successful completion of the registration process.

The support is provided off-line, by means of e-mail only. You may also use our answering machine or a regular mail to send a request for support; however, if you do not supply your e-mail address to which the author can send the answer, you will get the answer by regular mail (which can take pretty long time period).

See the Contact Info chapter for our address.



Price List

The price depends on the number of licenses you order; for multiple licenses significant discounts from the price are offered:

Number of licenses	Price for one license

1	$ 29

2	$ 23

3-4	$ 19

5 and more	$ 15

Site license	$ 199

Site license: is valid for an unlimited number of computers owned by one person or organization. The distance between any two of the computers must be lower than 1 km. 

There is also an unlimited license available; contact us for details.

Note: If you send check directly to us, you can also pay in another common currency; in such case recalculate the price using the current exchange ratio. 

See also:

Registration

What is Shareware?

Trial Use License

Software License Agreement

Limited Warranty

Distribution License

Technical Support

Contact Info



Contact Info

The author of the DiskBase program is Zdenek Martinek.

The home server for the DiskBase program is at

http://www.diskbase.com

You will find the latest information about the program there as well as a possibility to download its latest version and pay for licenses.

If you want to contact us, please prefer e-mail. If you are a registered user and need technical support, please read also the Technical Support chapter.

E-mail:	info@diskbase.com

Snail mail:	Zdenek Martinek�Masarykova 4�CZ-312 19 Plzen�Czech Republic

Phone / answering machine:	+420 - 609 - 46 34 30. Please use the phone in necessary case only. Prefer the GMT time 17.00-21.00, which is for example the local time:�  18.00-22.00 in most of Europe�  11.00-15.00 in U.S. & Canada Central Time�



This is the end of DiskBase User's Guide

Installation of DiskBase Is Complete

Thank you for installing DiskBase on your computer.

Please note that this program is distributed as a shareware and you may use it for a one-month evaluation period only. If you find it useful and want to continue using it after that period, you must purchase it.

See the following topics for details: 

What is new in this version?

What is Shareware?

Trial Use License

Limited Warranty

Registration

Distribution License

Contact Info



By using this program you acknowledge that you have read the Trial Use License and Limited Warranty, understand them, and agree to be bound by their terms and conditions.
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